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Module 12 Interchange

About this practice workbook

This PDF file includes bookmarks providing an overview of the document. Click on the bookmark
to quickly jump to any section in the file. You may have to turn on the bookmark function in your
PDF viewer, such as Adobe Reader.

The Module 12 - Interchange.zip file should be extracted to the root C:\.

All CADD and PDF files are to be accessed at C:\NCDOT Training\Roadway\ Module 12 -
Interchange.

All datasets used throughout this module used English units and U.S. Survey Feet.

This module was developed and tested using the latest NCDOT OpenX workspace and
OpenRoads Designer 2023

The NCDOT_WorkSets.inp on your desktop should be set to the following variables:
NCDOT_USE_LOCAL_WORKSETS =L2
NCDOT_UNIT_TRAINING_WORKSETS = Roadway

This training module used the DOT-US North Carolina WorkSpace, Training-Rd_R2635C Workset
and NCDOT_Roadway Role. These modules were developed with State STIP projects R-2635C.
All training files have been updated to be included in the training Workset but retain the STIP
project number.

The tool tips and help were copied from Bentley Online Help. See this link for the complete list of
tools and common usage.

OpenRoads Designer CONNECT Edition Help (bentley.com)

This module assumes the reader has either completed or can reference all previous training
modules referenced herein.

At the development of this module, the refenced survey file (_FS_) was completed in legacy V8i
format. Standard ORD survey delivery will vary slightly from what is presented in this module.

This workbook has been written with the NCDOT Roadway Design Manual (RDM) and NCDOT
Structures Management Unit Design Manual (SMU).

All training modules are posted on NCDOT Connect at the Roadway Design page.

Legend:

Working Files

Navigation/Selection Guidance

Online Hyperlinks (NCDOT Connect Site Only)
Local Document Reference Link
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Module 12 Interchange

1.0 Overview

The intent of Interchange is to lean on the lessons learned from the previous modules and to
introduce tools and methods that can be used when modeling or designing different elements of
a typical interchange. The means and methods introduced in this model do not replace the
guidelines set forth by AASHTO for the geometric design of the nation’s highways. Several
specialized templates have been created and will be presented to provide design controls to set
alignments and grades as well as validate designs. Additionally, several techniques will be
introduced to improve processes such as earthwork calculations, clearance checks, infield
modeling and more.

1.1 Geometry Ribbon
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Figure 1-1: Geometry Ribbon
1.2 Corridors Ribbon
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Figure 1-2: Corridors Ribbon
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Figure 1-3: Model Detailing Ribbon
1.4 Terrain Ribbon
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Figure 1-4: Terrain Ribbon
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Figure 1-5: Drawing Production Ribbon
1.6  Collaborate Ribbon
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Figure 1-6: Collaborate Ribbon
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1.7 Key Concepts, Tools, and Terminology

1.71  Design Intent

Design intent is the act of preserving rules and relationships established during the design
process to realize downstream benefits of automatic updates.

The information provided in these exercises are not intended to replace typical design controls
and procedures.

1.7.2  Linear Templates

Templates that can be applied quickly and easily to 3D linear elements but with less functionality
when compared to corridor templates.

1.7.3 Surface Templates

Atemplate made of components with an associated depth. These components are closed shapes
such as asphalt, concrete, aggregate, grass etc. Surface Templates are used to apply material
thickness to the surface of a terrain.

1.7.4  Terrain Modeling

A set of three-dimensional triangles mathematically computed from point data collected on the
surface being modeled. Models are used to define highly irregular surfaces, particularly the
surface of earth, but can be generated for proposed surface, subsurface geotechnical layers, etc.
Terrain models are also preferred to as digital terrain models (DTMs), triangulated irregular
networks (TINs), or triangulated surfaces.

2.0 Interchange Design Tools
21 Exercises Overview

Unlike previous modules, this training is a set of multiple exercises aimed at presenting many
different trainings within a single module. The working files are contained within the same folder.

In each exercise, you will follow each lesson and complete each outcome using predefined
horizontal and vertical geometry and predefined roadway corridors.

The mainline -L- carries our interchange bridge over the Y line.
Complete the following procedure prior to starting each training exercise:

1. Launch OpenRoads Designer Connect Edition
Double-click on the NCDOT OpenRoads Designer 2023 to launch OpenRoads Designer.

2. Select the Workspace and WorkSet
Select DOT-US North Carolina from the Workspace menu.
Select Training-RD_R-2635C from the Workset menu.
Select NCDOT_Roadway from the Role menu.
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WorkSpace WorkSet Role
DOT-US North Carolina ~ Training-RD_R-2635C - NCDOT_Roadway -

Figure 2-1: WorkSpace and Workset Selection

2.2  Structure Vertical Clearance Checks

Coordinate all vertical and horizontal structure clearances with the approved Design Criteria,
Structures Management Unit (SMU) and sections 5.3.3 and 5.3.4 of the RDM.

Coordinate preliminary and final structure depth and bridge digital twin models with SMU or the
Bridge Design Engineer. Refer to RDM section 5.3.4.2 for commentary regarding Bridge
Superstructure Depths.

In these vertical clearance exercises, you will learn how to prepare vertical clearance checks for
interchanges by using templates and running Results Reports and by using the “Clash Detection”
tool in OpenRoads.

221 Clearance Checks Using Templates and Reports

In this exercise, you will learn how to perform vertical clearance checks using templates and
OpenRoads reports. You will be using the preliminary roadway bridge model “stand-in” as well as
the roadway template for producing vertical geometry graphics.

1. Open the Roadway Bridge corridor file and zoom to fit view.
A. Click the browser button and path to the Module 12 — Interchange—
Vertical Clearance\Roadway\Design folder and open the R- \
2635C_RDY_CMD_Bridge_L.dgn file.

Active References:

r'..

-L- & -Y1- Superelevation Design

Tools  Properties

- E * > \ [ o : > % 7, 3 1/ Hilite Mode: | Boundari

Hierarchy St P 4 FileName * Description  Logical .

R-2635C_R.. 13 R-2635C_RDY_SUP_¥1.dgn Default Master Mod Roadway DeS|gn (2D)
5 R-2635C_RDY_SUP_L.dgn 1
15 R-2635C_RDY_DSM.dgn Default Master Model Ref-3 Coincident - world  veiretram 3
n R-2635C_ROY_CMD_Y1.dgn Default Master Model Ref-14l
12 R-2635C_RDY_CMD_L.dgn
9 R-2635C_RDY_CMD_Bridge_L.dgn Default-3D Ret _|__ & _Y1 - Models
3 MAlignment\R-2635C_RDY_ALG_¥1.dgn Default Master Model
2 AAlignment\R-2635C_RDY_ALG_L.dgn Default Master Model

10 WAStructures\R-2635C_SMU_Geometry.dgn
1 .uAFinal Survey\R-2635C_FS_ETM.dgn

Global Origi... Coincident - World Wireframe

-L- & -Y1- Alignments

Bridge Geometry (2D)
Scale [1.000000000 ETM (Electronic 00°0000 TFSet X 00000 Y TO000
l:"E: Terrai n Model) ments: * | Mesting Depth: |2 Display Overrides: -
< > New Level Display: -

Figure 2-2: R-2635C_RDY _CMD_Bridge_L.dgn References
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B. Zoom in near the intersection of -L- and -Y1- as shown below. Notice there is already
a base corridor for -L- and -Y- and a preliminary plan view geometry file for the bridge.
See the Initial Corridor Modeling Module for detailed instructions for initial corridor
development.

-Y1-
CORRIDOR

-L-
CORRIDOR

\ A
\ b

Figure 2-3: R-2635C_RDY CMD_Bridge L.dgn

2. Review the Roadway Bridge “Stand-In” template.

Note: the following information is intended to be the preliminary outline of a structure only
prior to the development of the Structures Preliminary General Drawings (PGD). This
information will be used to set interchange grades and check preliminary vertical
clearances. The bridge design engineer is responsible for providing the calculated
proposed structure depth and digital twin when the PGD’s are approved and accepted as
a part of the project.

A. Click on the “Create Template” button (Corridors > Create > Create
Template). '!"\"'
Ternplate
B. Select File, then Open and load the R-2635C (Training) RDY.itl file (Module -
12 — Interchange— Vertical Clearance\Roadway\Design folder).

C. Under the Template Library Organizer, window, navigate to the standard template
library (Configuration_2023 > Workspaces > DOT-US North Carolina > Roles >
NCDOT_Roadway > Standards > Template Library) and select the NCDOT_Standard
Templates.itl template library and bring over the Bridge Undivided 4+4 template as
shown below.
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| m Template Library Organizer m] X

Available In Available In:

{53 CANCDOT Training'\Roadway\Module 12 - Interchange Modeling'Module 12 - Vertieal | |23 C\NCDOT_CONNECT_WORKSPACE \Corfiguration_2023"Work Spaces\DOT-US Nor
"ZZ Point Name List "ZZ Point Name List Cancel
2 _waALL (23 End Condition
|3 BR_Surface [Z Shouder End Counditions
(£ Components 25 Template
21 DRI {23 Biidge (Freliminary)
|21 End Condtion = Bridge Divided 2+2
[C3 HYD1 = Bridge Divided 3+3
(QN = Bridge Divided 4+4
|21 Linear Templates >= Bridge Divided 5+5 = =
@ o = e e Wedan 2:2 Prelim. Bridge
104 = Bridge Raised Median 3+3
Z1 RPB = Bridge Raised Median 4+4 Tem plate
[C1 RPD = Bridge Raised Median 5+5
on = Bridge Undivided 1+1
[3 Y1VERTCHECK >={ Bridge Undivided 2+2
1 y2 = Bridge Undivided 3+3
= Bridge_Prefim_L b { Bridge Undivided 4+4]
= TMPLT-Shoulder Dual Lane Roadway - Overay and Widen Only = Bridge Undivided 5+5
3= UUF - 1+1 Lanes - CSLP (27 Divided Median Barmier
=< UF-1+1 Lanes - LDSS (X1 Divided Median Ditch
= UF-1+1 Lanes - LDS51 (2 Divided Raised Median
== VertCheck (£ Road-Rural {Undivided Shoulder)
2= VertClear_Single (21 Road-Urban {Undivided Curb & Gutter)
= VertClear_Single_Graphical (23 z-End Condition Exception-Ovemide

= blank
< 3| |« >
Preview: Preview:

Figure 2-4: Bridge_Prelim_L

D. Select “OK” and return to the Create Template dialog. Rename the template
“Bridge_Prelim_L”", activate the template and select the “Active Template” dialog.

E. Notice a few of the key Bridge_Prelim_L template points shown below and the loaded
parametric constraints.

It is understood that every bridge is different, and the template will need to be adjusted
to accommodate each situation. Below are a few key features and components of the
template and how they are intended to be used to replicate Roadway’s preliminary
bridge. Please note, this template has been slightly modified to include a GP line below
the CL point to coincide with the grade point of the typical section shown below.
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Deck Surface

Feature: TC_Bridge Girder
Concrete
BR_Deck Feature: TC_Conc Misc
Component

Level: P_RDY_TC_Concrete_Misc

BR_VertClear
Component

+ETO-_SBD
+BDO_B
Figure 2-5: Bridge Prelim_L Template
~BRO_FB CL 109'-3" (OUT TO OUT) +BRO FB
1-7%" // // \\ 106'-0" (CLEJ\R ROADWAY) \\S\ 1-7%"
520" ) | ) 5210"
N Deck Surface CA\%

1-7%"
Total Structure N
s/ Depth (ft)
CONST. "/_
T

1%
GRADE JSEE DETAIL "A"
POINT . %
A e
| —C J | 3
é:u?c 12 L 16" ‘ /\
(TYP.) i D—
3278 7A11r 711" 7+11" 7-11° 7-11" 11" 50" g-3" g-3* g3 | g-3" g-3* 3-7%"
/
E_BAYISSA_ oate - 12/2022] CL SBD _TYPICAL SECTION BR_VeﬂCIear
— Component

Figure 2-6: Bridge Typical Point Graphic

F. For this exercise, we will set the total structure depth to match the preliminary plans
shown above = 5-5”. In the Active Template dialog, under Parametric Constraints,
select BR_Depth Deck and set the value to -5.4167.
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BR_StrDepth
Constraint

+{:| Paints
+41-{°7 Components
{77 End Condition Branches

Cumrent Template
Name: |Bridge Prelim_L |

Description: | Created 2021.09.08 |

\ {7 Display Rules
& -5 etric Congtraints

Iz Tunnel Template

3 BR_Depth Deck
> BRO_Width Rail Offset
7> -BRO_Width Rail Offset

P LN_Width

P> -LN_Width

|21 Mtemate Sufaces

+-{_7] Point Feature Definitions
+{:| Component Feature Definitions

I I e W

Depth (ft.)

Total Structure

+-{°7 Classifications

t Edit Default Parametric Value
#-{21 Superelevation Points

Label: BR_Depth Deck

Default Value:

Figure 2-7: Structure Depth Constraint

The main component BR_Deck is excluded from the top/bottom mesh so seek elements
will not target the surface created by its output.

The BR_VertClear component is not excluded from the top/bottom mesh and is
intended to be the component the vertical clearance graphics will seek to determine the
clearances.

CL = Centerline or Bridge Grade Point
o Template origin and template drop datum.

CL_SBD = Bottom of the template, bottom of the structure depth
e Represents the preliminary full structure depth set by SMU.
o Parametric Constraint = BR_Depth Deck

+/~ BRO_FB = Deck surface, inside edge of bridge barrier.
e Constrained to CL by horizontal and slope.
e Horizontal Feature Constraints
o ~BRO_FB: CCE_Target_1
o +BRO_FB: CCE_Target_2

G. Close out of the Create Template dialog and save the changes to the template library.

3. Create the Roadway Bridge model.
A. Open the Reference dialog window and set the files to display as follows (Home >
Primary > Attach Tools > References):

In the default view, set the alignments for -L-, -Y1- and the SMU_Geometry file to
display and do not display any other references.
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On

Tools  Properties
E-B o £D¢EAP P Mg D I7 @ 5 HieMoe
Slet P 3 [=] FileName Model

10 L~ PW WORKDIR:dms78434\BR-0015_SMU_Geometry.dgn Default |
3 PW_WORKDIR:dms78425\BROD15_RDY_SUP_Y1.dgn Default
PW_WORKDIR:dms78425\BROD15_RDY_SUP_L.dgn Default

PW_WORKDIR:dms78425\BR0015_RDY_DSM.dgn Default
PW_WORKDIR:dms72425\BRO015_RDY_CMD_¥1.dgn Default
2 QBKDIR-degc7od05  BRONTS BOY ChAD | do [

v PW_WORKDIR:dms78423\BROD1S_RDY_ALG_Y1.dgn Default
v PW_WORKDIR:dms78423\BROD1S_RDY_ALG_L.dgn Default

BT WORRDT. drms 72300 BRO0TS.Fe E W dgn Detault
BROD15_RDY_CMD_Bridge_Y1.dgn Default-3D

Scale | 1.000000000 : | 1.000000000 Botation | 00°00'00" Offset X | |

m 17 B D B Nested Attachments: | Live Nesting

Mew Level Display: Config Variable ~ Georeferenced: |No =

Figure 2-8: Set References Display

Close the Reference dialog.

Next, we will be placing our construction class elements to target our horizontal feature
constraints in our Bridge Prelim_L model.

Note: this demonstration is for a bridge on a horizontal tangent at a skew. Similar
operations will be required for bridges on curved alignments with or without skews.

1. Setthe Feature Definition to CCE_Target 1. (left gutter target). This is under (Linear
> Roadway > Construction Class Element).
It is suggested to toggle Persist Snaps and Rules off and to toggle Use Active
Feature Definition on.

4 |CCE_Target_1 |€P€f’° & A ST
= Construction Class Element ~
----- @ CCE_Draft_LW_1

----- @ CCE_Draft_LW 2 _—
----- @ CCE_Draft_LW 3 EE Aty
----- @ CCE_Draft_LW_Blue
----- @ CCE_Draft_LW_Red
----- @ CCE_Draft_LW _White =y
----- @ )
----- @ CCE Target 2
----- @ CCE_Target 3
----- @ CCE_Target 4
----- @ CCE_Target 5

| Jl:!JUIU.-'L:' ‘IL.I | | lq!E_L &el

Figure 2-9: CCE_Target 1

2. Select the Single Offset Partial tool (Geometry > Horizontal > Offsets and Tapers).
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del Detailing Drawing Production Drawing Litilities Collab

g O @ —L Offsets and Tapers ¥ .7

Single Offset Entire Element

Lines  Arcs Point
-

w -

Complex
7 Single Offset Partial pasllia it

-L_ Variable Offset Taper
. ._._; / <L Ratio Offset Taper

Figure 2-10: Single Offset Partial

3. In this example the left offset from the CL to the ~BRO_FB is 53.0 ft. Select the -L-
alignment and set the Offset value to -53.00. Extend your placement limits beyond
the most extreme skew limits of the approach slab at each end. This will target point
~BRO_FB pointin our Bridge Prelim_L template. Please note that we are using the
extreme skew limits of the approach slab for simplicity in this example but that may
not be desired for all projects.

Ve

——— RN RNERNNNRY
Offset: -53.0000

|Use Spiral Transitions []

Mirror O Left Gutter/Inside

Remaove Offset Rule D Face Of Barrier

Distance

Lock To Start O
[ Start Distance 1842 8256
Lock To End [l
[] End Distance 2051.9969
[ Length 209.1712
Feature
Feature Definition Lse Activ Left Offset from -L-
Name cceT on Extreme app. slab

skew limits

Q

Figure 2-11: Left Gutter Offset

4. Repeat steps 1 through 3, activate the CCE_Target 2 Feature Definition and use a
+53.00 offset from the -L- to target the +BRO_FB template point. Be sure to extend
your offset lines beyond the extreme limits of the approach slab as indicated in the
previous steps.
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g | CCE _Target 2 - |4¢ IA P A 4

=I = View 1, Defaut =N
E:lr &~ & G

=

g Extreme app. slab

skew limits

Right Offset from -L-

6(_2,.

Parameters

= N P e 5 3 UERREERT

Offset:

Use Spiral Transitions [ ]

Mirror [l

Remove Offset Rule  []

Distance Right Gutterllnside

Lock To Star . Face of Barrier
[ Start Distance

Lock To End
[] End Distance
[ Length

Feature

Feature Definition [NERRERRNRNER

Mame

Figure 2-12: Right Gutter Offset

5. Following the steps outlines in Module 6 — Initial Corridor Modeling, create a New
Corridor (Corridors > Create > New Corridor) along the -L- alignment within the
limits of the Begin and End Approach as shown in Figure 2-11: Left Gutter Offset.

m Home Terrair Site Corridors Model Detailing Drawing Production Drawing Utilities Collaborate View b
a k {ﬁﬂ 7 Copy Template Drop 2% € ? @ | @ Define Target Aliasing 1 & ﬂ%
- - I IRD “— W | com s v

Hement = " - ftg Import Template o tae DB | @ Coridor References ™ T | (2 =00
@1 | Selection ‘= Corridor Pmplate Drop |{ Transitions ~ - Template Drop * S8l | 8, Conidor Clipping ~ - -
Primary Selection Create Edit Miscellaneous Supereleva
7 |CCE_Target 2
= “ : 1]
2 u View, Dok 1) Select “New Corridor
Em-an-[AlerOdsyd BEE|=
Q) . . .
il [ pm 3) Profile Element: Active Profile L
g -
il 4) Feature Definition: Final

Parameters ~
Locate Prfle Elemert 5) Name: Bridge Prelim L
Feature ~

Feature Definition Final ~

Mame Bridge_Prelim_L

Figure 2-13: Create Bridge_Prelim_L Corridor
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D. We are now ready to drop our Bridge Prelim_L template. Select New Template Drop
(Corridors > Create > New Template Drop). Set the beginning and end stations to your
extreme approach slab limits as shown previously, set the Drop interval to 5.00 and use
our Bridge Prelim_L template.

rridors Madel Detailing Drawing Production Drawing Utilities Collaborate View Help NCDC

,ﬁg ~f| Copy Template Drap 2 $ ? @ (@ Define Target Aliasing s 8?- ﬁ% w -
Il Import IRD i3

T ® Corridor References + Imy Create Caleulate

m Home Terrain Geol

5 k - a

Element .-, New & i Template Edit Edits P y

S Selection ‘= Corridffr Template Drop (| Transitions = = Template Drop  * %50 T8 Corridor Clipping Sec

Primary Selection reate Edit Miscellaneous Superelevation

o4 | CCE_Taget 2 vy
_ e |
2 a

g . ~ P 73 ’”
fm-ay-[EleerOs P &8s 1) Select “New Template Drop
q

o

1

g

E

FEEFFERRI L

2) Start and End Station: Extreme Begin and [ s
End App Slab Limits

3) Drop Interval: 5.000

4) Template: Bridge Prelim L

Figure 2-14: Bridge_Prelim_L Template Drop

1. We must add our target elements to the corridor to control the width of the bridge.

SRNRT |\u===d==&‘1muumm ------

Figure 2-15: Select Target Elements
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Click on Corridor References (Corridors > Miscellaneous > Corridor References),
locate our Bridge Prelim_L corridor and use your “Data Point” to add the references
to the corridor.

Geometry Site Corridors Model Detailing Drawing Production Drawing Utilities Collaborate View F
ﬂ IJ‘EI ~ Copy Template Drop | 2’-! '1:" ? @ Define Target Aliasin @ ﬁ%
: b Import IRD : i Corrider References = I

Mew Mew Create Calcula

- Template Edi
“orridor Template Drop Y Transitions = =

b= T8 Corrider Clipping ~

Edit Miscellanecus Supereleval

1) Select “Corridor References”

- = s C

[F=%|EoH "<
0PROY D BE| &

Data Point to Apply References to 2
selected elements.

I I'I=I=I=I=I=I=Im ======5 I

\ 3) Data Point to Accept

Figure 2-16: Add Corridor References

E. InView 1, right click and hold in space and select View Control > 2 Views Plans/3D and
you will see our Roadway Bridge has been created and the corridor references have
adjusted the bridge width to match the design but the bridge model needs to be
adjusted for the skew.

| Yiew Control kil 1 View

DE:' Copy [g| 2 Views Plan/3D

-3 Move (9 2 Views Plan/ x5

=37 Scale [ 2 Views Plan/Profile

<. Rotate (g 2 Views Plan/Superelevation
ST (3 2 Wiews Dlan/Sonereleauatinn /S

Figure 2-17: View Plan/3D
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T

Bridge_Prelim_L Widened

Figure 2-18: Plan and 3D View.

F. We are now ready to clip the Bridge Prelim_L model for the bridge skew. In the 3D
View, turn off the reference for the R-2635C _RDY_ CMD_L.dgn so that it is easier to
verify the clipping of the Bridge Prelim_L model. Inthe 2D View, there are two triangle
shapes drawn in, one at the begin bridge and one at the end bridge, that are on
Scratch_Level 0.

1. Go to the Corridors tab on the ribbon and select the Add Clipping Reference
(Corridors > Miscellaneous > Corridor Clipping).

2. Select the Bridge Prelim_L corridor as the corridor to be clipped, and then data
point to select the Scratch _Level 0 shapes as clipping references.

B View 1, Default o[BS | w o |[@ =
-8k~ b-s PLP0OGY EESE EBriE-b- L PO0OQNDHOREEHTHE
6@' - “ . . ”
e 1) Select the Corridor “Bridge Prelim_L
Clipping Reference 2 tems

2) Data Point to Accept

Clipping Reference 3) Data Point to Accept
o Clipping Reference

Figure 2-19: Adding a Corridor Clipping Reference.

3. In the 3D View, turn on the reference for the R-2635C_RDY_CMD_L.dgn. You
should now see that the bridge model matches the skew and ties into the model for
L.
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w8 View 2, Default-3D =BT
E-iw-b-i PP 0OND HoRED RTRE

" ‘i\ /
\\ \‘\\ﬂ»
DR \\
\ \$¢¢

Figure 2-20: 3D View.

G. Using NCDOT Training Module 8 — Superelevation, add superelevation to the bridge if
necessary.

4. Vertical Clearance Model
We will now use the Bridge_Prelim_L model along with our L and Y1 models to run a
vertical clearance check using a specialized template and export reports.

A. Click the browser button and path to the Module 12 - Interchange — @
Vertical Clearance\Roadway\Document folder and open the R-
2635C_RDY_VertCheck.dgn file. \

Active References (Default-3D):
L and Y1 models

@ References (7 of 7 unique, 3 displayed)
Tools  Properties

EE '| E ,ﬁ(o s X '-‘h {«. = )J )-] jj ///{ 1 ] Hilite Mode | Boundaries ~
Slot P A FileName ~ Model Description Logical QOrientation Presentation [ Oj ‘ @
7 ADesign'R-2635C_RDY_DSN.dgn Default-30 Master Model Ref-6 Coincident - World ~ Wireframe v

ADesigntR-2633C_RDY_CMD_¥1.dgn Default-30 Master Model Ref-
\Design'\R-2633C_RDY_CMD_L.dgn Default-3D Br- H
: : i idge_Prelim_L

6

5

4 .\Design'\R-2635C_RDY_CMD_Bridge_L.dgn TOTECTETToTOTET T

3 MAlignment\R-2635C_RDY_ALG ¥1.dgn Default-30 Master Model Ref- M odel

2 JMAlignment\R-2635C_RDY_ALG L.dgn Default-3D Master Model Ref-

1 AAFinal Survey\R-2635C_F5_ETM.dgn Master Model  Ref CINCITENT - W0oT TETTarme

Figure 2-21: Reference Dialog

It is recommended to evaluate the vertical clearance at all possible points for Y1. In this
exercise, we will check the vertical clearance and run reports at a single location. Our
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possible evaluation points are controlled by the template points output from our Y1
template and typical section.

—_
Evaluation
5 Points J @ -Y1-
e |
' ~ =|VARIES \ ] ' VARIES
8, 8 _|0-4) _ /AR.24ITO36 _ 04, _8
|
FDPSJ{ l ," I fFDPS
P V) .
ADE | C
090 POINT\ | @V 090
0.08 : ' - . 0.08
AN N = NN v ~
-~ \ g Q
T > ®
&) )
_ 11" 11" —
s
@ VAR. —D2)

Figure 2-22: Typical Section Evaluation Points

=8k EPO -HM.BEK_EPO_HMAXY Epo. Hwaxz
s 0 -HM: : +SK_ EPO_HMAX3

Evaluation
Points
“DRW .DES DIS

- N AW "
~F G R RRERAW i e 5# Bron 1 | -t EpEREs i WRAW
I £ R ~R@BC2 — =rO-BC1 . jpec? "—-—‘%E‘m\ GSO

=0 ¥ DJL_'_F‘CB_HE-:‘I - ERCBRREB2 EEPEBBE1 + ERCEBEE2 ~ GNCBART pr—rGSO_N
NULL SD [ 1 PSO._TEROBRBEB3 +ERCARBBY ABC Soafey

B

EX_CL_ELE-B
Figure 2-23: Y1 CMD Evaluation Points

In this exercise, we will be creating a corridor for an output template point from the
Y1_CMD model for the CL point in the template. It is recommended to recreate a
separate corridor for each evaluation point in the template when completing vertical
clearance checks.
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B. Inthe View 1, Default window, right click and hold and select Views Plan/3D as shown

previously in Figure 2-17: View Plan/3D.

C. Select the View 1, Default window again and open the References dialog. Set only the

CMD_Y1.dgn and CMD_Bridge_L.dgn to display.

CMD_Y1

References (8 of & unique, 2 displayed)
Tools Properties

B -0 % =D 4

t B 3 FileName Model
R-2635C_RDV_VertCheck.dgn Default-30

3 .\Design\R-2635C_RDY_DSN.dgn Default

7 \DesignR-2635¢_RDY_CMD_¥1.dgn Default

5 \Design\R-2635C_RDY_CMD_Ldgn Default

5 .\Design\R-2635C_RDY_CMD_ridge Ldgn Default

4 \Alignment\R-2635C_RDY_ALG_Y1.dgn Default

\Alignment\R-2635C_RDY_ALG_L.dgn Default

> 1 \.\Final Survey\R-2635C_FS_ETM.dgn Default

Rotation [00°00'00

Nested Attachments

Georeferenced: -

CMD_Bridge L

Figure 2-24: View Display

Hilite Mode: |Boundaries =

Description  Logical
Ref

Orientation ]
Coincident -World V'

Master Model Coincident - World ¥
Master Model Coincident - World W
Master Model Coincident - World W
Master Model Coincident - World ¥
Master Model Coincident - World W
Master Model Coincident - World ¥
Master Model Coincident - World ¥
Offset X [0.0000 v [0.0000
=] Nesting Depth: [1 Display Overri

D. Create a new corridor based on the template CL point as shown in the figure below:

Tl OperRoadsModeling  ~ [ S HE R « - # & 2 = pwilikes-pw.bentley.com:kea-pw-01\Documents\Projects\1202320.02 NCDOT ORD Module\Mod

m Home Terrain Geometry Site Corridors Model Detailing Drawing Preduction Drawing Utilities Collaborate

= k
o Import IRD @ 1 500
Element .o, New New ‘e Template Edit Edits f{ i Conidor References * 'm
1| Selection 1= Corridor Wgplate Drop '/ Transitions = - TemplateDrop  * % T Conidor Clipping ~

View Hely

ﬁ * 5 Copy Template Drop 521_' “:‘ ? @ ©® Define Target Aliasing o @ %

Create Calculate

Primary Selection

"/ [No Feature Defintion

71 1) Select “New Corridor”

uperelevatior

B View 1, Default
8 ez L 8 00—

£~

ProfileByTemplate.

Parameters

Locate Profile Element Active Profile: ProfileBy Template |~

B

Feature ~

Feature Definition Final b4

Name Y1_CL_VetClear

Final.

~

2) Select “CL” template
point from Y1_CMD

I | Corridor Name :
Feature:Name |51
Ly M Element s in a Readnly Relerence

Complex_Element: CL
Belongs To: Y1

Active Profile: ProfileByTemplate | Line
Level P ROY TL Cent&r\ine (Pavt CL T@

3) Set Profile to Active or

4) Feature Definition to

5) Name: Y1 _CL_VertClear”

Feature: Linear\Roadway'Template Points\Pavement\TL_Centerline

Figure 2-25: CL_VertClear Corridor
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E. Create a template drop using the template VertClear_Single_Graphical.

2] OpenRosdsModeling  ~ bA~ S H kS [ « ~ & & & < pwikea-pw.bentley.com:kea- pw-0T\Documents\Projects\1202320.02 NCDOT ORD Modulel
m Home Terrain Geometry Site Corridors Model Detailing Drawing Production Drawing Utilities Collaborate Wiew

a k ﬁ;ﬁ ,,Igl = Copy Template Drop y)__. [ ? @ @ Define Target Aliasing Ey %

Import IRD — 4 - 1,
Element — u per Template — B T8 M8 Corrdor References ~ T | [ ° o
@1 Selection Cnmdnr TEn'\pIatEDrnp 4 Transitions ~ = TemplateDrop 9 @8 Corridor Clipping + = =
Primary Selection Create Edit Miscellaneous Superelev

@Q‘NoFeature Definition ‘g. ’+f\ g ./

B View 1, Default
o~ &1 L © Of0M ae & =] L

7

Parameters

Lock To Start []
O stert [5+89.98
Lock ToEnd []
[ End [7+0154
Drop Interval [1.0000

BT B

Templste  [VedClear_Single_Graphical

Drop template to extents
of CMD_Bridge L

Figue 2-26: Vertical Clearance Temp/te Drop

F. Define the BR_SURF attached to the Bridge Prelim_L corridor as a Target Alias.

1 OpenRoadsModeling  ~ @~ O HE B « - » £ 2 = pwiikee-pw.bentley.comikea-pw-01\DecumentstProjects\1202320.02 NCDOT ORD Meduleé\Medule 12 - Interche

IE tome  Temsin  Geomety  Ste | Comidors | ModelDetaiing  Drawing Production  Drawing _ Utiities  Collshorste  View  Help  NCDOTR
3, k v ﬁ 7 Copy Template Drop | M & | ® Define Torget Alzsing | 5 W
lﬂ ;2

{ Import IRD R{ ¢+ Corridor References ~ I

Element Lley Lley = ——__Fdit Edits

FteDrop % Corridor Clipping ~ v - Sectior

Creatﬁ Ca\cu\atﬁ Dynar
£

Aliases

Pri 1) Select “Define Target Aliasing” Edit Miscellaneous Superelevation

L,

=i Ve, Dot 2) Select “Y1_CL_VertClear” Corridor =S
E

‘3— Target BR SURF

Surface or Corridar

3) Add “Corridor —
Bridge Prelim_L”
and hit “Apply”

L2 Move Up Locate Alias Eniries

Terrain Model - BROO1S  ~ Add -> Corridor - Bridge_Prelim_L Apply
Terrain Model - DB1
Y1_CL VetClea

Corridor - <- Remave

Corridor -

Corridor -

Corridor -
Corridor - T_0Scratch2

gl Corridor - T_0Scratch1

Move Down

»

Use Closest

Figue 2-27: VeC/ar Target Aliasing
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G. Activate View 2, Default-3D and view the template drop. Notice how the template seeks
only the bottom of the Bridge_Prelim_L.

L__'r||{|_'J_J||f.|

M

% “Bridge_Prelim_L” = — “Y1_CL_VertClear”
_ . . _ Template

Figure 2-28: VertClear Target Aliasing. Defaul 3D

“Bridge_Prelim_L”

—

Seeks bottom

“Y1_CL_VertClear” of bridge

Template

Figure 2-29: VertClear Target Aliasing, Bottom of Bridge

H. Next, we will use corridor “Results Report” to display the calculated vertical clearance
of our template drop. In Home > Model Analysis and Reporting > Corridor Reports,
select “Results Report”.

£ OpenRoads Modeling @ odEE e - T2 - CANCDOT Training\Roadway\Madule 12 - Vertical Clearance\NCDOT Training\Roadway\Module 12 - Interchange - Vertical Clearance\Roadw
Home | Temain  Geometry  Ste  Comidors  Model Detailing  Drawing Production Drawmg Utilities  Collaborate  View  Help  NCDOTRoadway

& None ~ | Default ({nene)) N Q U a- Q] @ k 1‘ % * &L %\ L ' e &

et Cy
= = - =y Explorer Attach PopSet  lement Element . Repots Feperr  Cwil | Corider Dynaic  Temain
E: =0 =Ll L : Tools ~ %‘% " Selection @ Tools~ [ v Selection =t Browser Analysis~ REpoMs~¥ planView ~Import~
Attributes Primary Jection Jection Model Anslysis and #  Component Quantities
o .
HE - S I
et i I 1] | Design Input Report
Explorer ReSUItS Report 9 Results Report B
B View 1, Default [ = e
Fil p—— Milling Report
e YRR o .
@ Items 8 Superelevation Report
& ool 48 Blementselection  — % [ |

Figure 2-30: Results Report
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IEEET B

[=

Select the
“Y1_CL_VertClear”
corridor

v v
St

Figure 2-31: Corridor Report, Corridr Selection

I. Inthe “Report Browser”, under “CorridorModeling”, select
“TemplateDropsContraints.xsl”.

Notice how the report shows the vertical clearance in the Vert Clear BR row at each
template drop point. This report can be exported to a PDF or exported to excel for
design documentation.

ﬂ Bentley Civil Report Browser - C\Users\abouchard\AppData'Local\ Temp'RP Tao Thwxgj.xml = i
Toaks Corridor name with respect to
G e Template DI - Alignment and drop location.

I CwvilGeometry

2000

Report Created.
‘M 4 CorridorModeling
CompleteCorriderDependencyReport.xsl

Corridor Medel Component Quantities Summary.xsl File Name:
Corridor Model Component Quantities.xs!|
CorridorList.xs! Corridor: Y1_CL_VertClear
KeyStationsToTIW.xs|
RoadwaySetup.sl Template: VeriClear_Single_Graphical -
TemplateDropucsl Start Station: 5+89.982Stop Stafion: 5+39.982 Interval: 0.000 Calculated Vertical
TemplateDropsConstraints.xs||
sT——— Clearance
I LegalDescription i
I MapCheck Oesgrmbon:
P - -- - Constraints -
I Milling Point Name X ¥ Type Value Slope Width  Delta
I Stakeout
I StationOffset CL_Bot_VertClear 0.000 0.000
I Superelevation oo 0.000 16611
I Templatelibrary \art_Ciear_BR 0.000
I Turnouts
I Tools Component: Ver_G00D
Description:
- -- - Constraints - - - -
Point Name X Y Type Value Parent Slope Width _ DeltaY
se I ect CL_Bot_VertClear 0.000 0.000

) 0.000 16611

Report

Vert_Clear_ BR 0.000 16.611

Template: VeriClear_Single_Graphical
Start Station: 5+80.0005top Station: 5+90.000 Interval: 0.000

Figure 2-32: Report Browser
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J. In addition, there is another useful report that can be created to display this data with
respect to the Y1 alignment.

K. Inthe View 1, Default View, set the Y1 alignment to display.

View 1, Default

B View 1, Default
E-élu-b-i 000

E References (8 of 8 unique, 3 displayed)

Tools  Properties

E-lRxe £2EA P HLAF@ X

;| Boundaries ¥

Slot P 3 FileName ~ Madel Description  Logical Orientation Presentation  [=] _J W &
2 R-2635C_RDY_VertCheck.dgn Default-3D Ref Coincident - World Wireframe v
g .ADesign'\R-2633C_RDY_DSM.dgn Default Master Model Coincident - World Wireframe ¥
7 ADesigniR-2635C_RDY_CMD_Y1.dgn Default Master Model Coincident - World Wireframe ¥
6 .A\Design\R-2633C_RDY_CMD_L.dgn Default Master Model Coincident - World Wireframe v
5 .MDesign'\R-2633C_RDY_CMD_Bridge_L.dgn Default Master Model Coincident - World Wireframe ¥
4 WMAlignmentiR-2635C_RDY_ALG_Y1.dgn Default Master Model Coincident - World Wireframe ¥
3 MAlignment\R-2635C_RDY_ALG_L.dgn Default Master Model Coincident - World Wireframe ¥
1 JMGAFinal Survey\R-2635C_FS_ETM.dgn Default Master Model Ceincident - Werld Wireframe ¥

Y1 Alignment

Scale 1000000000 + [1.000000000 RO Offset X | 0.0000 v 0.0000
EI=EN = FE s B e ] 2 ] = 7 Nested Attachments: [No Nesting ~ | Nesting Depth: [1 Display Overrides: [Allow = | New Level Display
Georeferenced: | No <

Figure 2-33: Display Y1 Alignment

L. Set the View Control to Plan/3D as previously shown in Figure 2-17: View Plan/3D.

M. Rotate View 2, Default-3D to view the underside of the bridge as shown.

1 T3] [ T

Prelim_Bridge_L

I Y1_CL_VertClear

Figure 2-34: 3D View, Bottom of Bridge

N. Using Station Offset Report, create a report that displays the vertical clearance with
respect to the Y1 stationing. In Home > Model Analysis and Reporting > Reports, select
Station Offset/Base Report.
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7 & @ .
HEEE et
Reports Report | Civil Corridor  Dynamic
- Browser Analysis Reports~ plan View

Horizontal Geornetry Report
Horizontal Point Report
Profile Report

1 Legal Report

¥ Map Check Report

~  Station Offset/Base Report

¥ Point Feature Station Offset Elevation Report

B Superelevation Report

Figure 2-35: Station Offset/Base Report Initiation

O. In View 1, Default, select the Y1 alignment.

= View 1, Default [felfre s | -
= Y bri PLPRONN EE SN

E
_1__
Complex Element 71

Feature: AlignmentNCDOT\PropiALG_Centerline Minor Roadway
Active Profle: Y11 Line
Level: P_NCDOT_Horizonts!_Alignment_Minor_Road ({none))
Ref. 4 (. WignmentR-2635C_RDY_ALG Y1 dgr)

Figure 2-36: Select Y1 Alignment

P. In View 2, Default-3D, select the top of the Vert Clear BR as shown below to select
the vertical clearance. Set the station limits for Y1 and set the interval along the
Baseline. After selection, Reset (right click) to accept the selections.
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| Offset Report - x| :
4 Parameters ~ }
Lock To Start O
e —
1 b Stert Station 15+89 98 |
Lock To End s
End Station
— . T :
Baseline Horizontal Cardinal Points [] Locate First Offset Element .|
. i . Y1.CL VertCléar: Vert_ Clear_Bf
Baseline Vertical Cardinal Paints O L
Belongs To: Y1_CL_VertClear 2
Level: Draft_RDY_Construction_Class_Element ((none))
Offsets ~
Offset Horizontal Cardinal Points O I
Offset Vertical Cardinal Points O —
Events -~ -
Include Event Foints
Interval -~ I
- :
Interval Along .
Offset -~
0 oree :

Figure 2-37: Vert_Clear_ BR Selection

Q. Inthe Report Browser, under StationOffset, select the
StationBaseVerticalClearance.xsl.

Notice how the report displays the same vertical clearance information with stationing
based on Y1. Notice this report does not mention which template point was analyzed.
It is recommended to add the corresponding template point to the exported PDF or
excel file(s).

File Tools

Cant
Civil Terrain
CivilGeometry
CivilSurvey
CorridorMadeling
Evaluation
LegalDescription Project: Defaul
MapCheck Description:
Milling

I
4 StationOffset
CivilToolsStationOffset.xsl
CivilToolsStationOffsetExtended xsl
ProfileExistingProposedElevation.xs| Baseline (Active) Y1
ProfileExistingProposedElevationExtended.xs! Alignment:
ProfileStationElevation.xsl Input Grid Factor: Note: All units in this report are in feet unless specified otherwise.
ProfileStationElevationASCllxs|
ProfileStationOffsetElevationASCllxs|
StationBaseCompare.xs|

3

Baseline
Alignment

File Name:

Last Revised:

Perpendicular Distance
from Active Alignment

StE‘!D”BESECW”j‘”ates-“' Active Alignment to Specified Alignment
StationBaseCrassSlope.s| Station Offset is 0.000 Vertical Clearance
StationBaseSimpliedCrossSlope.xs| Y1) Type 0 to
StationBaseSingle.xs!
StationBaseVerticalClearance.xs|
StationBaseWGrades.xs| 15+90.000 pat -16.627
E StationOffset.xs| 15+91.000 POT -16.672
StationOffsetAlongSingleAligng entaxs| _
StationOffsetAlongSingleAligng \ntExistGround.sl 1592.000 par 18732
StationOffsetAlongSingleflign] \tWRadius.xsl 15+93.000  POT 16,793
StationOffsetElevationFeature. 15+94.000 POT -16.853
StationOffsetNorthingEasting.: -16.913
inaf] -
5 7 5 H -16.973
StationOffsetWithVersine.xs|
StationOffsetWSmoaothingRad| Vertlcal -17.033
TransverseFeature.xs| clearances _17.093
VerticalFace.xs
I Superelevation -17.152
I TemplateLibrary 16+00.000 POT -17.211
: Tumouts 16+01.000  POT -17.271
| ! Took 16+02.000  POT 47330
16+03.000 POT -17.388
16+04.000 POT -17.447
a 16+05.000 POT -0.000 -17.506

Figure 2-38: Station Base Vertical Clearance
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2.2.2 Clearance Checks Using Clash Detection

In this exercise, you will learn how to use the OpenRoads Clash Detection to further evaluate

bridge clearances.

Bentley help documentation can be located at their website: Using Clash Detection and Clash

Detection Dialog.

This tool is primarily used in the OpenX environment to identity utility conflict but can be used in

to check clearances to objects and surfaces.

This exercise uses the Bridge_Prelim_L model from the previous section and continues a mainline

-L- which carries our interchange bridge over -Y1-.
Note: the desirable vertical clearance for this exercise
1. Open the Roadway Bridge corridor file and
A. Click the browser button and path to the
Vertical
2635C_RDY_Clash.dgn file.

Active References:

Clearance\Roadway\Document folder

is 16.5ft.

zoom to fit view.
Module 12 - Interchange —
and open the R-

[B] References (6 of & unique, 3 displayec
Tools  Properties

E-Bxe £9D4

-Y1- Model

Bridge_Prelim_L Model

..........

st A FileMame Model
3 R-2635C_RDY_Clash.dgn Default-3D
4 JADesigniR-26353C_RDY_CMD_Y1.dg Default
9 JADesigntR-2635C_RDY_CMD _L.dgn Default
10 WADesigntR-2635C_RDY_CMD_Bridge_L.dgn Default
B JAdlignment'R-2633C_RDY_ALG_¥1.dgn Default
2 JMAFinal SurveyR-2633C_FS_ETM.dgn Default
Scale | 1.000000000 : | 1.000000000 Rotation | 00°
| " : ” h-| |"51 B ¢_°|:| 5] I:I ] I:‘L— NEEtEtI Attachments:
Georeferenced: -

Figure 2-39: R-2635C_RDY _Clash.dgn References

B.

p—

\

If your views are do not already display the Multi-Model view, right click and hold in

space and select View Control > 2 Views Plans/3D and center both views to Fit View,

see Figure 2-17: View Plan/3D.
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o @] &= ™ View 2, Defauit-30
o= -l PPROWD P SR - -l A

-Y1-

Bridge_Prelim_L

Wuitodelviess = || 2 2 |4]31¢171s) B Il @8 @ XA x Y Z
Figure 2-40: R-2635C_RDY _Clash.dgn

2. lIsolate the BR_VertClear Component

A. Before we use the Clash Detection function, it is important to note that Clash Detection
only works on levels that are displayed in the model you are running the function in. In
the View 2, Default 3-D Model, click Level Display to open the dialog (Home > Primary

> Level Display).

ik
Q B =

Level Display

P

Explorer _l,_ﬂxtt?ch =
00T e = Level Display Flyout
Prirnary Selection

L. A £ w2
Figure 2-41: Level Display

B. Inthe Level Display dialog, select R-2635C_RDY_CMD_Bridge L.dgn, Default-3D and

only display the level:

P_RDY_TC_Concrete_Misc.
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| Select Bridge_Prelim_L Model |

= Level Display - View 2

o=
(o View 2, Default-30 EE
E-olu-b-d PPROAYNGLRZIF TS

O q e -
"é ?(ncme)v Levels = M -
=) DOV ool doc Do o

Ref, .\Design\R-2635C_RDY_CMD_Bridge_L.dgn, Default-3D

ef-1, b

T ok T o I o
-2635C_RDY_CMD_Y1.dgn, Default-3D
1U_DT.dgn

.\Desig _RDY_CMD L.dgn
Ref-3, .\Alignment\R-2635C_RDV_ALG_V1.dgn, Default-3D

BR_VertClear
Component

Default

Scratch_Level 0
P_RDY_TL_Pavement_Marking_Yellow
P_RDY_TL_Pavement_Marking_White
P_RDY_TL Bridge_Rail
P_RDY_TL_Bridge_Deck_Sub
P_RDY_TL_Bridge_Deck
P_RDY_TC_Pvmt_Concrete_Cement
P_RDY_TC_Concrete_Misc
P_RDY_Concrete_Barrier
P_RDY_TL_Subgrade_Daylight_Point
P_RDY_TL_Paved_Shoulder_Sub
P_RDY_TL_Paved_Shoulder
P_RDY_TL_Grass_Shoulder_MNormal
P_RDY_TL_Edge_of_Travel_Sub

Name Used

P_RDY_TL_Edge_of_Travel
P_RDY_TL_Draft_DNC_Null_Point
P_RDY_TL Ditch_Base_Mid
P_RDY_TL_Ditch_Base_Front

P_RDY_Concrete_Misc

P_RDY_TL_Ditch_Base_Back

Figure 2-42: Isolate Levels for Clearance Check

This isolates the bottom feature and level from the Bridge Prelim_L Model — the
BR_VertClear Component as shown in Figure 2-5: Bridge Prelim L Template and
Figure 2-6: Bridge Typical Point Graphic. This isolates the top surface of the proposed

roadway to evaluate for vertical clearances.

Isolate -Y1- Roadway Surface

A. In the Level Display dialog, select R-2635C_RDY_CMD_Y1.dgn, Default-3D and only

display the following levels:

P_RDY_TC_Pvmt_Asphalt_Surface_Course_Wedge

P_RDY_TC_Pvmt_Asphalt_Surface_Course

Note: if you have a mountable median, include the appropriate levels in your selection set.
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| Select CMD_Y1 Model |

= Level Display - View 2 —
% q View Display -

‘:’) ?(l‘lona]v Levels = lﬁ .

=S =R =

3 W O

(- View 2, Default-3D

= -E b PReROYE HozEE

=-[/8 R-2635C_RDY_Clash.dgn, Default-3D

Ref, .\Design'R-2633C_RDY_CMD_Bridge_L.dgn, Default-3D
Ref-1 4\ \Final SunveyR-2635C FS ETh.dgn

Ref-2, .\Design\R-2635C_RDY_CMD_Y1.dgn, Default-3D I

o e )
M\Design'\R-2635C_RDY_CMD_L.dgn

(B Ref-3, . \Alignment\R-2635C_RDY_ALG_¥1.dgn, Default-3D
9 9

Isolated Roadway Surface

R,

P_RDY TL Curb_and_Gutter Sub -
P_RDY _TL Curb_and_Gutter_Flowline
P_RDY_TL_Curb_and_Gutter
P_RDY_TL_Centerline_Sub

P_RDY_TL_Centerline

P_RDY_TC_Surface_Grass

P_RDY TC Subgrade
P_RDY_TC_Pwmt_Asphalt_Surface_Course_Wedge
P_RDY_TC_Pwmt_Asphalt_Surface_Course
P_RDY_TC_Pvmt_Asphalt_Intermediate_Course_Wedge
P_RDY_TC_Pwmt_Asphalt_Intermediate_Course
P_RDY_TC_Pvmt_Asphalt_Base_Course_Wedge
P_RDY_TC_Pwmt_Asphalt_Base_Course
P_RDY_TC_Pvmt_Aggregate_Base_Course
P_RDY_TC_Draft-DNC

P_RDY_TC_Curb_and_Gutter

P_RDY Slope_Stake Fill_Limits

P RDY Slope Stake Cut Limits .

Name Used ~

S -

.
ST R

——

Isolated Roadway Surface

W

Figure 2-43: Isolate Y1 Roadway Surface

4. Using Clash Detection to Evaluate Clearances.
A. Remain in View 2, Default-3D window and Open the Clash Detection dialog box
(Collaboration > Clash Detection > Clash Detection).

1 Drawing Production

Clash
Detection

Clash Petection

Drawing Utilities Collaborate
BEX A
Place Place Cloud

Label Mote by Points

Markup Tools

Figure 2-44: Open Clash Detection

B. Under Job, select “New Job” and call it Y1 L VertClear.
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H: Clash Detection - ¥1_L_VertClear

Job

;I:;}:: Clash Detection

| lob | FResults

s MNewlob

K Savelob
Duplicate Job

Rename loh

Delete Job
sy | Wpdate Job From Library Job  Results

ﬁ: Clazh Detection - ¥1_L_VertClear

|| Process Job 'ﬂl' H I:D | =

Visualize Sets E::g Al Jobs

Advanced Settings...

Exit |

Figure 2-45: New Clash Job

Navigating the Clash Detection Dialog Window:

There are several ways to perform a Clash Detection, in this demonstration, we will be
using Levels in our Criteria to perform our analysis. The same can be completed with

entire reference files.

A|B]| C

Results

[.il. H I:I:l | 3= | | x Crteia Rules Results

-~ Levels ~
{ﬁ All Jobs

“ Y1_L VertClear [ Include References’ Levels

% seta| D // A

Soft Clearance: |0.0000 ' | US Survey Feet

? (none) -

=10 ~
< Default

-+ Draft_Corridor_End_Cond_Exception

—+ Draft_Corridor_Graphics_Conceptual

+: Draft_Corridor_Graphics_Design

-+ Draft_Corridor_Graphics_Final

+ Draft_Corridor_Key_Station

+ Draft_Corridor_Point_Caontrol

< Draft_Corridor_Secondary_Alignment

-+ Draft_RDY_Construction

-1 Oraft_RDY_Construction_Class_Element

ﬁ| References v

@ Named Groups L

Figure 2-46: Clash Detection Window

[ Self Chagk

Soft Clearance: |0.0000 LS Survey Feet

[] Self Check
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A = Criteria Window

o Area to select levels, references or named groups to be included in the clash
detection.

B = Rules Window

e Used to turn on or off and manipulate suppression rules for the clash detection — we
will not focus on this window during this exercise.

C = Results Window

¢ Displays the details of each clash as well as the properties of the clashing elements.

D =SetA
o Criteria Set 1 (A) to be evaluated.
E =SetB

e Criteria Set 2 (B) to be evaluated.
F = Set A Clearance Check Value (ft.)

e Vertical Clearance value check.
G = Self Check Box

e |Leave unchecked.
H = Process Button

e Once all parameters have been established for the Clash, processes the Clash.

D. In the Criteria window, under the Levels selection set, check the box “Include
References’ Levels”.

Locate the level for the bottom of the deck from the Bridge Prelim_L model:
P_RDY_TC_ Concrete_Misc and drag it to the Set A box.

Set the Set A Soft Clearance to 16.5ft — the desirable Vertical Clerance for this facility.
Do not check the box “Self Check” for Set A.

In View 2, Default-3D, you will notice the level will be highlighted.

Clearance Check Value
4 H 2 x Criteria
{:: A sobe Levels ‘ Al W seta
Include References’ Levels Soft Clearance: |16.5000 WS Survey Fest
® Y1_L VenG o { S [te5000 1 Set A Box

P_ROY_TC Concrele_Mis _ e

-4 P_RDY_Siope_Steke_Cut_Limits
P_RDY_Slope_Stake_Fill_Limits
P_RDY_TC_EBridge_Girder_Concrete

o
Check Box

P_RDY_TC_Pvmt_Aggregate_Base_Cour

-~

Soft Clearan
[ Self Check

US Survey Feet

P_RDY_TC_Pvmt_Asphalt_Base_Course

izte_
-2 PLRDY_TC_Pymt_Asphalt_Intermedizte

Levels Dialog

Drag Level

Level Highlighted

Figure 2-47: Set A Setup

E. Locate the levels for the -Y1- roadway model:
P_RDY_TC Pvmt Asphalt Surface Course & Wedge and drag it to the Set B box.

Do not check the box “Self Check” for Set B.
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Do not set any values for the Soft Clearance for Set B.

Levels Highlighted

#= Clash Detection -
Job  Results
1 EH G =2 X Citeria Rules  Resuts
{;Nuh - Levels A Jf seta A
% Alobs
= ® Y1_L VeriClear Include References’ Levels Soft Clearance: [16.5000 | US Survey Feet
|? none) _‘ [] Self Check
4 P_RDY_TC_Concrete_Misc
- P_RDY_TC_Pvmi_Aggregate_Base_Cour ~
4 P_RDY_TC_Pvmi_Asphalt Bzse Course
+ P_RDY_TC_Pvmi_Asphalt_Base_Course,
4 P_RDY_TC_Pymi_Asphalt_Intermediate_:
& P_RDY_TC_Pvmi_Asphalt_| X
& P_RDY_TC_Pvmt_Asphalt_Surface_Cou W setB ~
& P_RDY _TC_Pumi_Asphalt Surface Cou
= P_ROY_TC_Prm:_Concrete. Cement Scht Clearance: [00000 | US Survey Feet
+ P_RDY_TC_Sidewalk [ Self Check
4 P_RDY_TC_Subgrade F_RDY_TC_Prmi_Asphalt_Surfzce_Caurse
& P_RDY_TC Surface_Grass v P_RDY_TC_Pvmi_Asphalt_Surface_Course_\
|¥| References v
Drag Levels |- oo S

4, Process Close

Figure 2-48: Set B Setup

F. Select Process and select the Results tab.

The analysis did not find any locations that violated our given vertical clearance criteria.

Job  Results :! Select Tab
.#,L-_I ED 2 :—; x Criteria  Rules RBS'-? =

375 Al Jobs i A=

=

v Y1_L_VertClear

. Results

Mo clashes found

(&) Element Info ~

Element Info A Element Info B

Y Process Close

Figure 2-49: Vertical Clearance Empty Results

G. Right Click Results under Y1_L_VertClear on the right window under All Jobs and select
Clear All. Click Yes to confirm.
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ﬂ: Clash Detection - ¥1_L_VertClear (0 clashes)

Job  Results

Crteria  Rules  F
-:'J:s ! ':ﬂ:‘ x

> A = Levels
{:3' | Jobs
= Y1 L VertCl Include Refer
3 ear

? (none)
Mew Group —————

P RDY TC
Clear gx Clear All b Brw T

P_ROY_TC_
P_ROY_TC_
| Clear all results in the job LTC_
‘ ~F ROV TC_
= P POY TC

Right Click

Figure 2-50: Clear Clash Job

Repeat the previous steps and change the Soft Clearance of Set A to be 17.0ft.
Hit Process and view the Results tab again.
In the Results tab, right click on any of the columns and select Show Columns and

Clearance to display the calculated clearance at locations where the Soft Clearance
“Clashed”.

1
Criteria  Rules

Right Click a Column
X% ¥ g

,{ﬁf'*¢ .

Mame Status Assigned.f—-ry;ea—f Element Label A 2
T T | o
# | Clash New Clear) A+ Sort Descending
¥ |Clash2 Mew al Custom Sorting... .
¥ | Clash6 New Clea Show Columns 3 Status Image
-
¥ |Clash2 New Clear, Freeze This Column v | MName
< Show Filters Description
(&) Element Info 3@ Find.. ZI Status
Element Info A Elemert e 8 ZI Assigned To
General ~ N General Assigned By
Element Descr BR_VertClear Element Descr ~PV_SC1 Assigned On

P_RDY_TC_Concrel Level P_RDY_TC_Pw Accepted By
E= Bylevel (14) Co BylLevel (1

E= Bylevel (0)

E= Bylevel (3) v

Accepted O
] ByLevel (0 e

Bylevel (2 Resolved On

Found By
Found On
Element ID A

More...

Figure 2-51: Clear Clash - Add Clearance Column

The analysis found several instances where the clearance of 17.0ft was not satisfied
between the Set A and Set B components.
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He Clash ) - . _ x
« = Violation Clearances . e
o Violation
2 |Ca X Instances
| .
S 0 YI_L_VerClear Name  Status | AssignedTo | Type | ~Clearance  Element Laby & Graphlcs
T ¥ Cos0d | New Ceoarce 165145 | Heshuface
¥ Clash01 New Clearance 165146 Mesh Surface
¥ Clash02 | New Clearance 165984 MeshSurface
¥ | Clash08 | MNew Clearance 16.6351 MeshSurface
» ¥ Clash10 | New Clearance 16.6391 Mesh Surface:
% Clash05 |New Clearance 16.6680 Mesh Surface
v
- e e
e L
o -~
Violation Instances Bement rfo B
~ o General ~

Jes BR_VertClear
P_RDY_TC_Conc|

~PV_SC-W1
P_RDY_TC_Pvmt|

C BylLevel (14) ByLevel (1)
Li Bylevel (0) Bylevel (0)
Bylevel (3) Bylevel (2)
Primary Primary
T (None) v (None) v
1 Process Close

Figure 2-52: Vertical Clearance Conflict Results
H. The clash results can be exported to an excel file for record keeping.

I .
ri= Clash Detection - Y1_L_VertClear (11 clashes) — X
Job | Results
| XK Clear All Crteia Rules Resufts
+| .,
iﬁ | Export All » | Excel/CSV... Ancls ” <+ I
-y
= Display Settings... GPS“; by A
| Exports information on the clashes to Microsoft Excel supported formats r__a
T T T T T T
¥ |Clash0l  |[New Clearance | 16.5146 MeshSurface
¥ (Clash02 | New Clearance | 16.5984 MeshSurface
¥ |Clash08 |New Clearance | 16.6331 MeshSurface
» ¥ (Clash10 | New Clearance | 16.6351 MeshSurface
¥ |Clash0% |[New Clearance | 16.6680 MeshSurface
W
L4 >
Figure 2-53: Export Clash Results
A B C D E F G H J
1 |Job Name _Sratus Number of Clashes Started At Ended At
2 |Y1_L VertClear Completed successfully 11 1/14/2026 15:28 1/14/2026 15:28
3
4 |Parent Name Job Name Status Assigned To Type Clearance ElementLabelA Element LabelB Location (WGS84 Datum - Longitude, Latitude, Elevation)
5 |Root Clash01 ¥1_L VertClear New Clearance 16.5146 MeshSurfaceEntity Linear - Stations Offsets -80°16'30.8", 35°49'34.3", 223.3350
6 Root Clash02 ¥1_L VertClear New Clearance 16.5984 MeshSurfaceEntity Linear - Stations Offsets -80"16'30.8", 35°49'34.3", 223.3350
7 |Root Clash03 ¥1_L_VertClear New Clearance 16.7584 MeshSurfaceEntity Linear - Stations Offsets -80"16'30.8", 35°49'34.3", 223.3350
8 Root Clash04 ¥1_L VertClear New Clearance 16.5146 MeshSurfaceEntity Linear - Stations Offsets -80716'30.8", 35°49'34.3", 223.3350
9 |Root Clash05 ¥1_L_VeriClear New Clearance 16.668 MeshSurfaceEntity Linear - Stations Offsets -80°16'30.8", 35°49'34.3", 223.3350
10 Root Clash0g ¥1_L VeriClear New Clearance 16.9666 MeshSurfaceEntity Linear - Stations Offsets -80°16'30.8", 35°49'34.4", 223.1684
11 |Root Clash07 ¥1_L VertClear New Clearance 16.8094 MeshSurfaceEntity Linear - Stations Offsets -80°16'31.2", 35°49'34.4", 222.2276
12 Root Clash08 ¥1_L VertClear New Clearance 16.6391 MeshSurfaceEntity Linear - Stations Offsets -80716'30.8", 35°49'34.4", 223.3350
13 |Root Clash09 ¥1_L_VertClear New Clearance 16.723 MeshSurfaceEntity Linear - Stations Offsets -80°16'30.8", 35°49'34.4", 223.3350
14 |Root Clash10 ¥1_L VertClear New Clearance 16.6391 MeshSurfaceEntity Linear - Stations Offsets -80716'30.8", 35°49'34.5", 223.3350
15 |Root Clashll ¥1_L_VeriClear New Clearance 16.7929 MeshSurfaceEntity Linear - Stations Offsets -80°16'30.8", 35°49'34.3", 223.3350
16

Figure 2-54: Exported Clash Result Excel Table
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2.2.3 Clearance Checks Using Structures Digital Twin (DT)
YouTube video: https://www.youtube.com/watch?v=kEKXS17ZQ1w

Clash Detection can be used in the same manner as previously described to verify vertical
clearances with an official Digital Twin once provided by SMU or the Structures Engineer of
Record. A “Digital Twin” is the 3D digital bridge output by OpenBridge.

A. Click the browser button and path to the Module 12 - Interchange — g
Vertical Clearance\Roadway\Document folder and open the R- ()
2635C_RDY_Clash.dgn file. “

B. Select View 2, Default-3D and expand the window to the full screen.

C. In the References dialog, set the structure’s Digital Twin to display and do not display
the Preliminary Bridge Model (R-2635C_RDY_CMD_Bridge_L.dgn).

® View 2, Default-30
E-di-b-[dPPOOADNGUEERNRTXR

Digital Twin Model

@ References (& of & unique, 3 displayed)

Preliminary Bridge Model

Tools  Properties

E B XS $DER L5 BB 15 @ R it Bonim s

St P 3 FileName ~ Model Descri Orientation Presentation [=] _f W &
3 .\Design\R-2633C_RDY_CMD_¥1.dgn Default-3D e Model  Ref-2 Coincident - World Wireframe v oY v
5 .A\Design\R-2633C_RDY_CMD_L.dgn = Global Origi... Coincident - World Wireframe ¥
1 .ADesign\R-2635C_ROY_CMD_Bridge_L.dgn Default-30 Master Model Ref Coincident - World Wireframe ¥ v
6 AAlignment\R-2635C_RDY_ALG_Y1.dgn Default-30 Master Model Ref-3 Coincident - World Wireframe ¥ ¥ ¥
4 JAAStructures\R-2635C_SMU_DT.dgn Default Master Model Coincident - World Wireframe ¥ ¥ ¥
2 Wﬂ Paster Model Ref-1 Coincident - World Wireframe ¥ '

Digital Twin Model Figure 2-55: Display Digital Twin

D. Open the Level Display dialog and isolate the P_SMU_Concrete_Girder level in the
Digital Twin model.
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W View 2, Default-3D

& Level Display - View 2 — X ‘
2y O View Dispiay ad Digital Twin Model Concrete Girders

% [ ¥ cono~ [Leves +] A - —

-8 R-2625C_RDY_Clash.dgn, Default-3D

Ref, .\Design\R-2635C_RDY_CMD_Bridge_L.dgn, D
Ref-1, .\ \Final Survey\R-2635C_FS_ETM.dgn
ef-2, .\Design\R-2635C_RDY_CMD_¥1.d
\AStructurest\R-2635C_SMU_DT.dgn
\Design\R-2635C_RDY_CMD_L.dgn
Ref-3, M\Alignment\R-2635C_RDY_ALG_¥1.dgn, Default-30

efault-3D

Name Used ~

Default .
P_SMU_Wingwalls
P_SMU_Steel_Pile
P_SMU_Grout_Pad
P_SMU_End_Bent_Cap
P_SMU_Concrete_Slab
P_SMU_Concrete_Girder
P_SMU_Concrete_Barrier_Rail
P_SMU_Bearings
P_SMU_Bearing_Seats .
P Shal) Rnder ot Concrete Girders
P_SMU_Approach_Slab
PS_WORKFRAME

Figure 2-56: Isolate Girders

E. Create another clash job called DT _VertClear and set the conditions as shown.

= Clash Detection - DT_VertClear — X

J[D:J;Eg\ﬂl e 17ft Clear Check

;:} I i - : P seta

Al Jobs

¥ DT_VerClear 4 Inc ferences’ Levels Soft Clearance: o= Sur
| Y (rene) - Self Check

< P_SMU_Concrete_Girder

= P_RDY_TC_Curb_and_Gutter  ~
&+ P_RDY_TC_Draft-DNC

= P_RDY_TC_Pumt_Agaregate Bz
= P_RDY_TC_Pvmt_Asphalt_Base
& P_RDY_TC_Pvmi_Asphalt_Base
&+ P_RDY_TC_Pvmt_Asphalt_lnten
= P_RDY_TC_Pvmt_Asphalt_Inten P setn A

Soft Clearance: US Surv
] Self Check
= P RDY TC_Sidewalk -+ P_RDY_TC_Pumt_Asphalt_Surface_|
- P_RDY_TC_Subarade &+ P_RDY_TC_Pumt_Asphalt_Surface |

#| References v
e .

| @ Named Groups v |

Figure 2-57: Digital Twin Clash Set-Up

F. Clash Results are similar to the Preliminary Bridge Model and can be analyzed and
exported similarly for the project record.
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#i= Clash Detection - DT_VertClear (7 clashes) - x
Job  Results
Ciiteria Rules  Resuits
RS e
308 A1 dobs 2t 5E 5} Tt e
= DT_VeriClear Name  Status Assigned o Type Clearance  Hement Label A~
* [Clash3 | New Clearance | 16.7812 | SolidEntity
¥ (Clash2 | New Clearance | 16.8668 | SolidEntity
¥ [Clash5 | New Clsarence | 16.9057 | SolidEntity
¥ (Clash7 | New Clearance | 16.3058 | SolidEntity
¥ (Clashd | New Clearence | 16.9354 | SolidEntity
v
< >
(@) Element Info ~
Element Info A
GeometryAspectRule ~ " "~
newDrivingRul True scr +PV_SC1
P_RDY_TC_Pvmt |
SolidEntity ~ ByLevel (1)
e ev
v v
&, Process Close

Figure 2-58: Digital Twin Clash Results

3.0 Infield Modeling

The NCDOT Standard drawings references in the following exercises are:
o 225.07 Grading for False Cuts at Grade Separations
o 225.09 Guide for Shoulder and Ditch Transition at Grade Separations

We will be using the same file to build out all modeling details at the -L- and -Y4- grade separation.
The suggested workflow presented in these exercises keep the -L-, -Y4-, and the details in
separate CMDs to allow for flexibility when creating cross sections and performing earthwork
calculations. The working DSN file used in this exercise has been trimmed to contain linework
only within the limits of the grade separation and should not be considered complete. The concrete
slope protection has been added to both bridge end bents. For simplicity, the concrete slope
protection does not extend beyond the limits of the bridge. The concrete slope protection and the
bridge digital twin is not 100% modeled in these exercises.

1. Launch OpenRoads Designer Connect Edition
Double-click on the NCDOT OpenRoads Designer 2023 to launch OpenRoads Designer.

2. Select the Workspace and WorkSet
Select DOT-US North Carolina from the Workspace menu.
Select Training-RD_R-2635C from the Workset menu.
Select NCDOT_Roadway from the Role menu.

3.1 False Cuts at Interchanges (Standard 225.07)

In this exercise, you will learn how to model the NCDOT Standard 225.07 for False Cuts and
Grade Separations. Please see video titled NCDOT Module 12 — Std 225.07.

1. Open the -L- and -Y4- details CMD model and set your window to

display the plan and 3D view. —
A. Click the browser button and path to the Module 12 — Interchange Module
— Infield  Modeling\Roadway\Design  folder and open R- \

2635C_RDY_CMD_Details_L_Y4.dgn.
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Active References (Default View):

E| References (17 of 17 unique, ¥ displayed]

Roadway Design (2D)

Tocls  Properties

E R ¥ = ¢

o -L- and -Y4- Models

Scale | 1.000000000 : [ 1.000000000

- (el ) [ e Bl [ =

Georeferenced: | Mo 4

Slot ‘P 4 File Mame ™
3 R-2635C_RDY_DSN.dgn
13 R-2635C_RDY_CMD_Y4.dgn Default Master Alignment File
12 R-2635C_RDY_CMD_L.dgn Default
_ . R-2635C_RDY_CMD_Details_L_Y4.dgn =
Bridge Digital ..mlignmenth-zﬁﬁc_RDv_ALG.dggn/Elef;@h/"rﬂl/_
Twin (3D) \.A\Structu..\R-2635C_SMU_BRG_09_Geometry.dgn Bridge Geometry (2D)
10~ \.\Structures\BR...\R-2635C_SMU_BRG_09_DT.dgn Default
2 .\.\Final Survey\R-2635C_LS_FS.dgn Dafault ]
14 \.\Final Survey\R-2635C_L5_ETM_COMBINED.dgn  Default | Survey
P RN

ETM (Electronic Terrain Model)

Mested Attachments: | Lin

B.

Figure 3-1: R-2635C_RDY_CMD_Details_L_Y4.dgn References

In View 1, Default view, zoom near the grade separation of -L- and -Y4- as shown

below. Notice there is already a design layout for -L- and -Y4-. If you navigate to the 3D
View (as shown in Figure 2-17: View Plan/3D), notice the -L-, -Y4-, the Bridge and the
concrete slopes have already been modeled. There are marked, dedicated quadrants
where we will be modeling the various standards listed previously along with scratch
lines that have already been laid out which corresponds to the standards.
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" Figure 3-3: Infield Details, 3D Models

2. Modeling 225.07

A

mo O

It is important to note that while we are modeling the grade separation details in a
standalone model, it will be necessary to update the models of -L- and -Y4- to
correspond to the modeled limits of the details.

The -L- model has an End Condition Exception applied to remove the end conditions
past the grass shoulder at the areas we are about to model.

In the View 1, Default — References dialog, turn the references for the -L- and -Y4-
CMDs to display.

In the upper right quadrant, we will now model the Standard 225.07.

Navigate in the Corridors ribbon to Create — Template — Create Template and load the
R-2635C (Training) RDY.itl from the Design folder.
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Geometry Site Corridors Model Detailing Drawing Produ

I"‘I 1 Copy lemplate Drop w\‘ l&}d
ﬁ Y Import IRD
New New Template Edit

h Template Dro

Corridor Template Drop | Transitions ~

Create

Create Template |

:ﬁ‘? ‘./',&-\ _;e’w. .-J_a'i & Import Template

= Display Template 1

Figure 3-4: Load Template Library
F. We will be using the FalseCut template located in the Infield Modeling folder.

Template Library:

a —
== Paint Name List
[ Mignments

23 LinearTemplates

== ShoulderDitch_Fill
LNT - C&G

LNT - C&G_LT

LNT - C&G_RT

LNT -FS

LNT -PS0O

LNT -PSO_LT

LNT - PSO_RT

LNT - Slope Abutment
[ Surface Templates

=
=
=
=
=
=
=
=

Figure 3-5: Template Location

G. Close the Template Library Dialog.
H. Navigate in the Model Detailing ribbon to 3D Tools — Apply Linear Template and apply
the FalseCut linear template to the grass shoulder between marks G and A.

m Home  Temsin  Geomety St Comi Model Detailing  Drawing Production  Drawing  Utilies  Collaborste  View  Help  NCDOTRoadway
A k bl J}_{ 2k Create Civil Cell —\ & @ x ‘>ﬁ %
W - 7 process Civit Call o 5 fidl
Element .., Place Apply urface  Create Create <
@] Selection 1= Civil Cell 2k Drop Civil Cell Lmeavprgmp\ate femplates *  Closed Mesh Elements * Conic Slope
Primary Selection Civil Cells 3D Tools
o > g -
& o 2%
Explorer v EX
# ViewT, Defautt fol o ] | »
A Fil v ; . iy = .
Hee @réli|b-[EReLRNY D EE BN E-ols-b-|d RRBOAD|HeRBE|S
¢ Items vz
& Resources v Parameters 73
 Opetonde i | s o Locate Grass
Q QL. [ Start Station 0.0000 Sh Id
2 R-2635C_RDY_CMD_Details L ¥4dgn (Default) Lock To End m] ou er
# Alignments O End Station 0.0000
> & Terrain Models Exterior Comer Sweep Angle [00°0000"
il corridors Mirror. a
b &\ Linear Template Reflect a
b A Surface Templates Template LinearTemplates Infield Modeling \FalseCut
ok Civil Cells Description [225.07_NE Quad
& Superelevation e— 7
» /" Lincar Geometry Name 22507 NE Quad
E2 3D Linear Elements
+ Points
b < Referenced Models
& Sight Visibility Sections
@ Aquaplaning
o
75 Conicslope
» [ site Layout
)
e e
Complex. Blement. ~GS0_N
Belongs To: 13
&5 Sheet Index hd Feature: LincarlRoadway \Template Points\Shoulder and BermiTL_Grass Shoulder Normal Outside
Active Profile: ProfieBy Template \ Line Strin
B Links v Level: P_RDY TL Grass_Shoulder_Normal (Earth Shoulder Top)
Ref. Ref T (R-2635C_RDY. CMD_L dgn)
OpenRoads Standards v
Drainage and Utilties Model v

|
Figure 3-6: Apply FalseCut Linear Template
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Figure 3-7: FalseCut 3D View

I. Next, we are going to set the 30:1 ditch taper that begins at the concrete slope
protection that controls the center of the ditch.

The center of the ditch taper is controlled by the DBM_NULL point in the template and
seeks the Construction Class Element: CCE_Target 1 feature definition.

Name: DEM_NULL V| ﬂ Apply
[ Use Feature Name Ovemide: DEM_NULL

Close
Feature Definition: v Nao Feature Definition
[ Superelevation Flag

< Previous

Ml Atemate Surface:

Member of :

Ditch
control point

Constraints

Constraint 1
Type: Horizontal v

GSO_FC

[8.0000
DBF_FC DBM_ (S [FC_DitchWidth -]

. . L
Horizontal Feature Constraint  + \Construction Class Element\CCE_Target_1

Range: 0.0000

Figure 3-8: FalseCut Template Ditch Control

Using the Geometry > Horizontal Geometry tools > Ratio Offset Taper, place the 30:1
taper with respect to the -L- alignment between points G and C, with CCE_Target 1 as
the active feature definition.
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&
Parameters

[ Start Offset  -57.0000

Ratio -30:1
Mirror O
Distance
Leck To Stert [

[ Start Distance 296+20.50
Leck ToEnd [

] End Distance 300:20.50

[ Lenath 400.0000

[(RRRRRRN

Feature

Feature Definition  Use Active F

Name

Parameters

[ Start Offset  |-67.0000

Ratio ,
Mirror O I
Distance

Lock To Start [

[ Start Distance | 296220 50

Lock ToEnd [

[ End Distance |298+85.07

[ Length 264.5724

Feature

Feature Definition | Use Active Feature

CCET_ONE

Name

\\l|l|l||llllllllllllIII|I

CCET_ONE

Start Parameters - <Alt> Lock To Start
meters:Start Offset | EENIIIN

|
)

i
[RRRRN
IIIIIIlilll\llllllllllllllll %

/ d Parameters - <Alt> Lock To End
W S| Parameters:Ratio 4
Line
Level: Scratch_Level 5 ((none))

Figure 3-10: FalseCut, 30:1 Taper End

Apply the target to the corridor as a reference. Go to the Corridor > Miscellaneous >
Corridor References > Add Corridor Reference, and select the 225.07 NE Quad Linear
Template as the corridor, and select the CCE_Target_1 line drawn in the previous step.

J. Now we are going to set parametric constraints to control the back slopes to match the
Standard. Set parametric constraints as follows:
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oo | = ===
E-AE-b-d PPROQD HUREERD ATXSE
£ Comidor Objects - 225.07_NE Quad - o X
- = X * w 4

) Constraint Label Ena. St Swop.  Stert Slope Stop Slope S ¢ Stan Station End Station
External Reference FC_DitohBack Siope True 50.00% 40.00% 11:53.65 12:53.38
Clipping Reference FC_DitchBackSlope True 40.00% a3 12+63.38 13-5297
FC_DitchBackSlope True 13z 25.00% 1345297 14:5263
FC_DitchBackSiope Tre 25.00% 16674 1445263 15:52.68

FC_DitchBack Slope True 16.67% 0.00% 15+52.68 18+52.76

<|lefl«| <] ¢l

Figure 3-11: Ditch Back Slope Parametric Constraints & 3D View

Station values are where the reference scratch lines intersect the paved shoulder point.
K. Next, we are going to set and control the top of the berm.

The center of the top of the berm is controlled by the BermMid NULL point in the
template and seeks the Construction Class Element: CCE_Target 2 feature definition.

Using the Horizontal Geometry tools > Single Offset Partial, place the Construction
class element at a constant offset from the paved shoulder following the targeted
scratch line in plan view alignment between points G and C. This location was
determined by drawing a line tangent to the wingwall on -Y4- to where it intersects with
the paved shoulder on -L-. This intersection point is where the concrete slope
protection under the bridge will meet the paved shoulder on -L-. This is where the
NCDOT Std 225.07 will end (point G in the figure). The offset distance for the berm
can be found by drawing a line perpendicular to the paved shoulder on -L- from the end
of the wingwall, in this case it is 37.7318.
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Name:

[] Use Feature Name Ovenide
Feature Definition:

[ Superelevation Flag
Altemate Surface:

Type:

Parent 1: | DBM_NULL

BermMid_NULL v #|

Bermiid_

~

Ppply

Close

L]

Berm
control point

Constraint 2

Vertical

~ 4| [DBM_NULL

Value [16.5000

[0.0000

Label: |FC_DitchBackWidth

\\\
\ |

Horizontal Feature Constraint

Range

~ “Construction Class Element'\CCE_Target_2

0.0000

BermMid FC

mMid_NULL

Figure 3-13: Distance for Top of Berm Offset to -L- aved Shoulderi

/ Lne

General -

Templste  (None)
Transparen 0

Priority 100

Geometry -~
Start 2265964.6602".618(
End 2265948.3306".618(
Length 377318

Dire 52573 "W

DelaX  -16.3295
DelaY  -34.0152'
T 377318
2265964.6602".618(

End Point 42.2306".618(
Lent | 377318 |
Direction W

Extended ~

Default

fic 7/16/2025 1:21:15
Snappable  Snappable
Modified  Not Modified

Locked  Unlocked
Line St
Di

(From View Disj
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- x

= B View 1, Default Ta I'get

B-SE-b-d PLPROYDEER IR

A Pass-
P Through

Point (G)

E [ Offset 377318

Use Spira Transitions [

- Offset from
Remove Offset Rule [ [ —|
: S ~PSO

Lock To Start O | / p
Start Distance: | |
Lock To End - /

End Distance
Length
Feature -~ N

Feature Definition

Name [CCET_TWO

rs:Offset. | EEREIE

Y

LAIESIE AR

Figure 3-14; FalseCut, Berm Tp Begin

= X e ot Offset from
m-ai-b-i202] ~PSO

Target

P

=T Pass_

iy [ Offset

B Through
Mirror O P0|nt (c)

Remove Offset Rule [

Distance ~

Lock To Start
Start Distance K
Lock To End O ML RIS
End Distance !
Length 338,775
Feature Bl No Active Profile | Arc
oo Botion — fll L=< Oraf_FOY_Construction_Class._Element ((none))
Name

TR T R R S SN AN SRR RN ENT] D T T

|
R R R R R ERE R R R R R R EE R

FEFFREREEFRRFEERRREEEEERERRRRREEERE

HIEJRIIRIIR

e L—

Figure 3-15: FalseCut, Berm Top End

Apply the target to the corridor as a reference.
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L. We are now ready to clean up the interaction of -Y4- and our linear template.

Open the Define Target Aliasing dialog (Geometry > Miscellaneous > Define Target
Aliasing). Select the Corridor — Y4 corridor, move it above the Terrain Model — Complex
Terrain, and add it to the Aliases selection, Select Use Closest and hit apply.

|rﬂ Define Target Aliasing x
l Target: <Active Surface> “’

Surface or Corridor Aliases

Terrain Model - £8 Add -> Corridor - ¥4 Apply

Terrain Model - Complex Ten Terrain Model - Complex Ten

Corridor - ¥4 <- Remav
Corridor - L3

Corridor - Y4_BB_ConcSlope
Corridor - ¥4_EB_ConcSlope

Close

Select

Add corridor to
aliases

v Use Closest

Figure 3-17: Define Target Alias
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» View? ElE=]
Br-E-b-|d PPRO4] HUREDRTXS

N

Figure 3-18:FalseCut -Y4- Targeted

In the View 1, Default view, locate the green Scratch Level 2 shape. This will be used
to clip the linear template 225.07_NE Quadrant around the concrete slope and -Y4-

corridor.

AP hhkTp;;:tEEEE::EE_EEE_L'IE_EEEJ T
N NN FN NN N a A aa oy

-  J - |
Figure 3-19: FalseCut Concrete Slope and -Y4- Clipping Shape

Add that shape as a clipped reference for your linear template 225.07_NE Quadrant.
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& Corridor Objects - 225.07_NE Quad

Parametric Constraint

Point Control b
External Reference

Clipping Reference

Figure 3-20: FalseCut, Clipped Slope

Now we need to clip out the -Y4- model for the overlap area with the linear template
225.07_NE Quadrant. Open the R-2635C_RDY_CMD_Y4.dgn file.

# View 2, Default-3D [
E-dE b2 LPRAOGYNHAURER IV

("

Figure 3-21: FalseCut, Overlap of -Y4- Corridor

We need to revise both corridors to tie in to each other. We cannot use the -Y4-
corridor as a clipping reference for the linear template in this instance or we get a
result that looks like this:
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Figure 3-22: FalseCuts, -Y4- Added as Clippin Reference . 225.07_NE Quadra orridor, Incorrectly

We cannot use the 225.07_NE Quadrant corridor as a target alias for the -Y4-

Corridor because the -Y4- Corridor is being used as a target alias for 225.07_NE
Quadrant.

To solve this issue, we will need to clip the -Y4- Corridor to a shape where it overlaps
with the 225.07_NE Quadrant Corridor:

1. In the R-2635C_RDY_CMD_Y4.dgn, locate the Scratch_Level 2 shape in View
1, Default.

B View 1, Default EI@
b4 2L0O9 N EE HY

1y
’
’
‘,

’
",
i

Figure 3-23: Scatch_Level 2 Clipping Shape
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2. Add the Scratch_Level 2 Shape to the -Y4- Corridor as a clipping reference
(Corridors > Miscellaneous > Corridor Clipping > Add Clipping Reference).

g e J— J—

ate Drop .}]_‘q & ? ¥ @ Define Target Aliasing ofu @ % E' < E
1

B & Corridor References ~ 1a

Template Edit Edits | Create Calculate Dynamic 3p[
N Template Drop 7 &1 @ Corridor Clipping ~ N M £ Sections * Thro
Edit Miscellanecus Superelevation Rev

BT

B View 1, Default
= v b-d PRLOOYDN EE HED

Add

Clipping
Reference

ey g
%t—, Shape
e:e\ Scratch_Level_2 ((none))

Figure 3-24: Add Clipping Reference for -Y4- Corridor
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B View 1, Default e ] | -
B -au-b-s LLROYY P HYS

N\ .
& Corridor Objects - Y4

~

Curve Widening
Name

LinearEntity2dinPlan

Bl e IneaErtyathrln 8l -Y4- is no longer overlapping
e 225.07_NE Quadrant

End Condition Exception

< >

Figure 3-25: -Y4- Corridor Clipped

And add that shape to your clip references and your model should then be clipped to
Y4.

= View 2, Default-3D m@@

Figure 3-26: FalseCuts, Y4 Clip

Page | 52




Module 12 Interchange

The last step is to fil in the gap between the two templates at the wing wall. We will
complete this by using a point control and a profile. Open the R-
2635C_RDY_CMD_Details_L_Y4.dgn.

First, create a piece of geometry with any construction class element (CCE_Target_3)
with an offset of Oft from the piece of geometry we used to control the horizontal location
of the top of the berm (CCE_Target_2).

&1 OpenRoads Modeling ~ B HE B « - o & 5 pwi\ikea-pw.bentley.com:kca-pw-D1\Documents\Projects\North Carolina\1202320.02 NCDOT ORD Madule\Module 12 - Interchange Modeling\Infield Model
Home  Temain  Geometry  Site  Comidors  Model Detailing  Drawing Production  Drawing  Utilties  Collaborate  View  Help  NCDOTRoadway

& k 0 ;77 Offsets and Tapers ~ \f" i’; EB Open Profile Model |_ I: I‘L‘ T I Et
i = — = el

i Reverse Curves ~ <4 Set Active Profile

* & Import/Export ~ P 5 - O

>y

44 Design Elements ~

Element . Civil  Reports Point Medity _Complex Lines Curves Element Modify Complex  Transh
| Selection 1=+ K - o v v 2 Spirals ~ ~  Geometry~ | |1 Profile Creation * ~  Profiles v = Geometry~
Primary Selection Slng Ie Herizental Vertical

J |ceE_Target 3
B ) offset

@
1':1 B View 1, Default

S|4 0L Partial

Oft

BH

aiideg g

Parameters
Dffset
Use Spiral Transitions []
Mirror O

Remove Offset Rule

Reference

~

Distance

Lock To Start O
[] Start Distance
Lock To End [}
[ End Distance
0 et

~

Feature

Feature Definition Use Act

CCET_THREE

End Parameters - <Alt> Lock To End
Jo--56.53] 4

nd Distance

Figure 3-27: FalseCuts Reference Profile

Then open the profile model of the piece of horizontal geometry you just created and
perform a 3D Cut at approximate elevations shown in the figure below. Use the
placement method Full Profile.

Linear
Details

Figure 3-28: FalseCuts 3D Cut
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On the Geometry tab, use the Profile Line Between Points tool (Geometry > Vertical >
Lines) to create a quick profile that follows the Y4 slope and intersects the Linear
Details, and set the profile as active.

® View 3, Profile - CCET_THREE == <
E'j-:.:' EE &EE CI’_"_L bvﬁ IQI"_/?‘;/&'

Finally, create a Point Control in the 225.07_NE Quad Corridor to control the
BermMid_FC point to be controlled by the profile we just created.

P
Parameters -~
Lock To Start d

Start [10+53.88 |
Lock To End O

Stop [11+09.18 |
Control Description |Berrn_T0p |
Point [Bembia_FC ]
Mode [Both v
Contral Type |Unear Geometry ~ |
Plan Element |CCET_THREE ~ |
Prafile Element |A.c‘tive Profile: CCET_THREE ~ |
|Use as Secondary Mlignment [
Priority |'I |
Vertical Offsets -~

Start [0.0000 |

Stop [0.0000 |
Horizontal Offsets ~

Start [0.0000 |

Stop [0.0000 |

Page | 54



Module 12 Interchange

3.2

Completed
details

Shoulders at Interchanges (Standard 225.09)

In this exercise, you will learn how to model the NCDOT Standard 225.09 both for fill and cut
approaches.

3.21

Fill Approaches (Standard 225.09)

In this exercise, you will learn how to model the NCDOT Standard 225.09 for Fill Approaches. We
are going to use surface templates to create a conical slope around the bridge abutments. The
paved shoulder taper as has already been modeled. Please see video titled NCDOT Module 12
— Std 225.09 Cut.

1.

Open the -L- and -Y4- details CMD model and set your window to

display the plan and 3D view. j—

A. Click the browser button and path to the Module 12 — Interchange Module .
— Infield  Modeling\Roadway\Design  folder and open R- \
2635C_RDY_CMD_Details_L_Y4.dgn.

See Figure 3-1: R-2635C_RDY_CMD_Details_L_Y4.dgn References for references.

B. Set your View Controls to Plan/3D and navigate to the Southeast Quadrant.
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Work Area

Figure 3-31: Infield Details, Southeast Quadrant

C. Select the View 1, Default window, open the References Dialog and add the file R-
2635C_RDY_CMD_Y4.dgn to the plan view and select the Default-3D model.

B View1, Default w

14 - b-4 PO DERSEG

4

E| References (15 of 15 unique, 4 displayed)

BN Tools  Properties

=B xo (9CRRPRGATOR

Slet 4 FileName ~ Medel
g R-2635C_RDY_DSN.dgn Default
57 R-2635C_RDY_CMD Ya.dgn Default-3D
A R-2635C_RDY_CMD_Y4.dgn Default
12 R-2635C_RDY_CMD_L.dgn Default
6 R-2635C_RDY_CMD_Details_L_V4.dgn Default-3D
1 .AAlignment\R-2635C_RDY_ALG.dgn Default
3 AAStructu..\R-2633C_SMU_BRG_09_Geometry.dgn Default
10 A AStructures\BR.. AR-2635C_SMU_BRG_09_DT.dgn  Default
2 .\\Final Survey\R-2635C_LS_FS.dgn Default
14 .\.\Final Survey\R-2635C_LS_ETM_COMBINED.dgn Default
<
Scale | 1000000000 : | 1.000000000 Retation | 00°00'00"

T = &[] [&] = 7 Nested Attachments: [No Ne

Georeferenced: | No -

Figure -32: Infield Deti/s, Adding -Y4- 3D Reference

D. There are several ways to create a conical slope around bridges, in this example, we
are going to make a terrain and utilize surface templates.
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Select the feature definition CCE_Target 1, set as Active Feature Definition, and use
the Horizontal Geometry — Lines -Line Between Points tool to trace a horizontal line
along the Y4 fill slope.

€l OperRosdsModeling  ~ A O HE B « - » ﬂ B s pwilk D Carolina\1202320.02 NCDOT ORD Module\Module 12 -
L Home Geometry | Site Model Detailing  Drawing Production  Drawin Uiilties  Collaborate  View  Help  NCDOTRoadnay
a Z Import/Export //“ 3 Offsets and Tapers \rﬂ f‘f B8 Open Profile Model 12

W - 95 Design Elements X Reverse Curves * ¢ Set Active Profile
l i \ Reports an Moty Complex Lines Curves Elem
@i Se % Standards * Toggles * 2 Spirals metry \,Qv ofile Crestion = - * Profih

Primary Selection Horizontal Vertical

2‘ = View 1, Default
L PLPOOYD BB ST

o o [

CCE_Target_1

.......

Figure 3-33: Trace Y4 fill slope

Open the profile view of the recently placed line and create a 3D Cut (Full Profile
Placement Method). Create a piece of vertical geometry that traces the Y4 fill slope
(Geometry > Vertical > Lines > Profile Line Between Points) and make the vertical
geometry the active profile.

-4 &2 5 pwiikea-pwbentl kea-p jects\North Carolina\1202320.02 NCDOT ORD 12- Interchange Modeling (R5829)\NCDOT Training\ Roadway\Modul
Corridors ~ Model Detailing ~ Drawing Production  Drawing  Utilities  Collaborate  View  H NCDOT Roadway
b P77 4 /“ , I Offsets and Tapers ™ \},_J r{ EH Open Profile Modkl JL 3 [ e 7 -
i 4 ~ = [aS) 2a v
Y < 4 ¥ Reverse Cures - % Set Active Profile| L / ;’, / D 1
Civil  Reports | Lines Arcs Point Modify _Complex Lin Curves Element Modify Complex | ransform Sl Complex Tile e
oggles v vv v 2 spinls v v Geometry~ | | Profile Creation - v Profiless v Geometry~ ety Reathre Eaiter poibist -
sols Horizontal Vertical Common Tools
IV

=& ==

ofile - CCET_ONE1
Lepprer som = .- slds A

7 Trace Fill Slope

-
,
.
o

-

Edge of wing [ e

wall

" Figure 3-34: Y4 Fill Slope Profile
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Next, repeat the same steps to create horizontal and vertical geometry to trace along
the concrete slope protection.

ol ] AN el B A/ T Y

B View 1 Default

Parameters -
[ Distance 422508 -
[ Line Direction |N35°58'57.9"E . EEEEEE RN

R s e e o o o R e e e R e L b ]

________________________ .

Feature

Start at end of 5 |
wing wall | 8 End at
i o paved
shoulder

- o”HE B a2 €O s o\ owbentioy comikezpu! jects\North Carolin\1202320.02 NCDOT ORD 12 - Interchange Modeli

7 OpenRoads Modeling
Home

Geometry | Site rawing  Utiities  Collaborate  View  HelwmmenbdaB OT Roadway

CCE_Target_1 [+ -~ ~ Frioi b= X 0

i Import/Export ~

Element Modify _Complex Lines Qrves Element Modify Complex  fransfo
@ | Selection = * Geometry™ | Profile Creation - - Geometry ~
Primary Selection Horizontal ol

® View 6, Profile - CCET_ONEZ
v PPROOEBER SE= 5 .- H

a2 T e

shoulder

Parameters -

O Length 42.2513
0 sese

Feature ~

Feature Definition | L

Name CCET_ONE

Start at end of
wing wall

gth | FEREE O
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The last step before we make our terrain is to make the conical base and geometry.
Use the Horizontal — Arcs — Arc Between Points tool and create an arc that connects
the end of the concrete slope protection trace and Y4 fill slope trace.

©) OpenRoadsModeling - @~ O k5 & - » & = 5 pwilikca-pw.bentley.com:kea-pw-01\Documents\Projects\North Carolina\1202320.02 NCDOT ORD ModuleiMedule 12 -
Home  Temain  Geometry  Ste  Comidors  Model Detailing ___ DrawingProduction  Drawing  Utilities  Collaborate  View  Help  NCDOT Rosdway

Z Import/Export ~

=Y k @2 e P d Pl oF | B O e o U
] ~ 7; Design Elements L L

Element oo /[\‘v\\\ Reports | Lines | Arcs pline = ReveseCunves ™\ iy Complec | 8 SStActiveRrofile o v Hem
@z Selection 1=¢ W Standards ~ Toggles - - 2 Spirals * + ° Geometry~ b~ Profile Creation ~ - - Profili
Primary Selection General Tools Horizantal Vertical
@ca&jangeu - ‘ gq" '+ A ﬁ.-' i /
: | m—

B

® View 1, Default
Brélii- 4 PRISOYD BHHG

Start at paved
shoulder

End at bottom
of slope

&

Parameters
I Placement Method

[ i ST T e I

[ Radius Value )
[ Start Direction
[ Start Tangent Direction I

[ End Tangent Direction r == i T T .. T

[ Sweep Angle 60°5548"

O s tensh .y
O band ]
Feature -~ f

Parameters: Radivs Value | EIEEEE O
Complex Element. CCET_TW04
Feature: Linear\Roadway(Construction Class ElementiCCE T4
No Active Profile
Referenced By Corridor: L3 Arc
Level: Draft_RDY_Construction_Class_Element {[none))
Ref. Ret-1 (PwW_WORKDIR:dmsB87111R-5828A_RDY_CMD_L dgl
I 7
"

Feature Definition

Hame

CCET_ONE

[

Fiure 3-37: Horizontaof Bottom of Conical Slope '

Open the profile view of your newly placed arc and trace the top surface of the proposed
ground and existing ground to create the bottom profile of your conical fill (Geometry >
Vertical > Complex Geometry > Simple Profile by Pl).
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?] OpenRosdsModeling  ~ [B~ O H kd 5 « « 4 & & 5 pwiikea-pw.bentley.com:kea-pw-0T\DocumentstProjects\North Carolina\1202320.02 NCDOT ORD Module\Module 12 - Interchange Modeling\Infield Modeling (F
Home  Temain  Geometry  Site  Comidors  Model Detailing  DrawingProduction  Drawing  Utilties  Collsborste  View  Help  NCDOTRoadway

q k @0 2 Import/Bport T Xl 55 » !/" , ¥ Offsets and Tapers ™ 7 ff BB Open Profile Model 1\ | | JL "F" ~ =
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T &

. - I Reverse Curves * 54 Set Active Profil
L Element =2 Civil  Reports  Lines Arcs Paint — ooe Ve Modify _Complex CHVERIONE  lines Curves Element Modify | Complex || Transform
@3 Selection =7  Standards * Toggles ~ - v v v 2L Spirals ¥ v Geometry~ |} Profile Creation ~ v v Profiles~ v eometry * '
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o [coE_Taret_1 “e% 1',-+- A | /
5 1 T
= -
 View . [E=HECR =
= i PPROYD EIAHR | Profile |z D e
B~ B YEE o - H

EErElEE

H

Existing
Ground

First Line

Figure 3-39: Outline of Conical Slope

Next, we will make a terrain out of the 3 pieces of horizontal and vertical geometry that
outlines our conical slope.
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3| | View2, Defsut-0 ==
@~ -~ 4 PO« Dty 7

[=oa 2 I o be | Tepwg

2. Set Parameters
and Features as

....................................

Figure 3-40: Create Terrain

Now that we have a terrain created, we can add a surface template to it. Note that you
may need to open the R-2635C (Training) RDY.itl again to access the SFT-Grass
Surface Template.

| 1. Surface Templates

S5 | View2 Oebauht30
- 'k

Figre 3-41: Apply Surface Template

These actions create a flat conical slope based on our outline.
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Figure 3-42: Flat Conical Slope

To give the slope advanced definition, we can add a break line to the terrain. Start by
adding a line that starts at the wing wall and intersects the middle of the arc.

.02 HEDOT ORD Module Module 12 - Interchange
Help  NCDOTRosduay
B oo bt bindal 1

End at middle
of arc

Start at end
of wing wall

g i

3

Figure 3-43: Terrain Break Line

Use the Profile Intersection Point tool to help create the profile of your break line.

%) OpenRosdsModeling  + [A~ S HE B €« - 4 £ 2 5 pw\kea-pw.bentley.com:kca-pw-0T\Documents\Projects\North Carolina\1202320.02 NCDOT ORD Module\Module 12 - Interc

B3 o Ste  Comidors  Model Detailing

Utilies  Collaborate ~ View  Help  NCDOTRoadway

a 17 . BB OpenProfileModel [\ | (@
i e = Fie b = 1R
B Civil  Reports  Lines : Lines Curves Element
@ | & z nes Ares Poink A > Profiles -
Primary on e s [ZaY
BT cce Taret et M A ST -
ol i een Poi
|=I| = View 1, Default L -
e - 2
S LRLeOs = =N
& [
£ /

igue 3-44: Profile nteec ool
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D s pwlk bentl kca-p: Carolina}1202320.02 NCDOT ORD Module\Module 12 - Interchange Modelin
Model Detoiling  Drawing Production  Drawing  Utiities  Collaborate  View  Help  NCDOTRoadway

7 2 ffsets and Tapers ~ EH Open Profile Model o |® -3- ]
L o D= & T

7 Set Active Profile T N

ines Curves Element Modify Com

ation ~ Profiles ~ Geom

£ oI PI'Ofile Vertical
- .| Profile Intersection
~m Intersection Reference

Reference

Profile
Intersection

L LROEE ST B v Bok A

Profile
Intersection

Figure 3-45: Profile Intersection Tool

Then create a vertical profile between the two intersection points and set it as active.

Figure 3-46: Break Line Vertical Profile

Finally, add the break line to the surface template/terrain to add advanced definition to
the conical slope.

Under Terrain — Edit, select Add Features tool. Select the EB terrain we recently
completed in the 3D View and set the Feature Type to Break Line.
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@ Select
~~~~~~~~~~ o S Break Line [

Break Line

Figur 3-48: rk ine Added to Terrain
3.2.2 Cut Approaches (Standard 225.09)

In this exercise, you will learn how to model the NCDOT Standard 225.09 for Cut Approaches.
We are going to use and modify the existing -L- CMD. Please see video titled NCDOT Module
12 — Std 225.09 Fill.

1. Open the -L- CMD model and set your window to display the plan and

3D view.
A. Click the browser button and path to the Module 12 — Interchange Module
— Infield  Modeling\Roadway\Design  folder and open R- \

2635C_RDY_CMD_L.dgn.
See Figure 3-1: R-2635C_RDY_CMD_Details_L_Y4.dgn References for references.

B. Set your View Controls to Plan/3D and navigate to the Southwest Quadrant.
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|  View 2, Default-3D - ) mtdm

Figure 3-49: Cut Approaches Work Areas

A PLPROQD HoREEE

C. Make sure the R-2635C_CMD_Details_L_Y4.dgn is set to display in View 1, Default.
This will provide you with the scratch lines mentioned previously.

D. In either the Create Template or Edit Template Drop dialog, open the -L- template for

editing.

1 File Edit Add Tools

| Template Library

Curert Template

| [ pwivkcapw bentiey comcapw-DT\Document
“ZZ Poirt Name List
E9 Alignments
QL
F DF - 2+2 Lanes AUX Median Ditch
Cave

(23 LinearTemplates
(2] Suface Templates

< >

Lbrary_Active Template |

Preview

Name: |DF - 2:2 Lanes AUX Median Ditch
Desciiption:  |Created 2021.05.26 - Modfied 2021.09.07
Is Tunnel Template

-L- Template

*=45H-tDu

Display oK
(® Components () Constraints

Display Paint Names
[ Display Al Components

Cancel

Figure 3-50: Open -L- Template

E. Make the following changes to the template to manipulate the end conditions later:

Modify the +DBF point to have a horizontal
Ditch_Bottom_Front with a range of 0.

feature constraint of
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Is Tunnel Template: [ Display All Components

EEa—

b s e
[ Use Feature Name Ovemide: -Dg Close

Feature Definition: v aints\Grading\TL_Ditch Base Front| [~ o o

[] Superelevation Flag

Next >

End Condtion Properties
[[]Check for Interception Member of

. +55_CDF
[]Do Mot Construct
Constraints

Constrairt 1 Constraint 2

Type: Slope ~ Horizontal ~
Parert 1:  [.Gso_N v #| [«ason o] #]
Parent 2: O T e

Value [1687% |[=] [80000 = B i . / y
hei ! et e ! \ NG E i shA

[ Horzortal Feature Cansiraint |+ Linear\Roadway'\DitchDitch_Bettom Front

s =
Set
horizontal
contraint

Cmimor [ Reflect

Figure 3-51: +DBF constraints

Modify the +C_HNG point to have a label for Constraint 2 to control the hinge
height as shown.

Is Tunnel Template [ Display All Components

T —Y =

[ Use Feature Name Ovenide: C_HNG

Close
Feature Definition: ~sints\Grading\TL_Cut Slope Hinge) | Previous
[ Superelevation Hag
Next >
Atemate Surface: S_Grading ~
End Condition Properties
[] Check for Interception Member of
R 85 C21
SECiONEe E #55_CH
[[] End Condition is Ifinite
[ Do Not Construct
Constraints
Constraint 1 Constraint 2
Type: Slope ~ Horizontal ~
Paent1  [.pEB ~ 4| |[-DeB v+
Parent 2 O Rollover Values
Walue: 25.00% =

Label: |

[ Horizortal Featurs Constrairt

o+ -

Figure 3-52: +C_HNG_HT label

F. Apply all your changes and save the template. If you updated the template in the
template library, be sure to Synchronize the template.

Use the Horizontal — Offsets and Tampers — Ratio Offset tool to make a 30:1 taper,
referenced to the -L- that will guide our ditch transition, using the feature definition
Ditch_Bottom Front. Start the geometry at the intersection of the concrete slope and
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the paved shoulder and end the geometry where it intersects the proposed center of
the ditch (from points A to C-Adjust).

Primary Selection General Tools Horizontal

@Dﬂch_l}uﬂom Front ~ |g€? ri l“|'“‘ ,-A-\ .,g'.. Uj /

2 & View1, Defautt Set
F-ddell ® 00R&nmE gy feature

‘ Jseunjdg 0 | | [N

e ——

e
¥ i ¥  ERgE REERLES
' T ERREIEEE e i I
FRTTRREEEE ey

it

—_——
——

-
-—
—
—————

—— e

Figure 3-53: Ditch Control

G. Now create a piece of geometry that will control the 8:1 taper for the grass shoulder
using the feature definition CCE_Target GSO_RT. Use the existing +PSO point as your
reference line and continue the geometry until it intersects the ditch line we placed in
the previous step.
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@ccs Target_GSO_RT Tla @JZHH A ? P

% ® View 1, Default Set
fp-Q-l1 0 00Man mE| 56

2 feature
o

e

Ditch control from
previous step

——

Fgr 5: Grass Shoulder Target 1

H. Next, use the tool Horizontal — Offsets and Tapers — Single Offset Partial and offset the
remaining ditch control line with the grass shoulder control geometry as shown:

B View 1, Default

Tosiell 0 0BPANPD &g CCE_Target_GSO_RT

e

_————
e ——

o ——

Add key stations at the start of the grass taper and at the intersection of the new grass

taper and the ditch control (Corridors > Edit > Edits > Create Key Station).
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B View 1, Default
Feaiell © P0ManmE| gg e

[ ré

Figure 3-55: Key Stations

J. Now add all the three control lines to the corridor as external references and notice how
the grass shoulder tapers to the ditch line and the ditch and grass shoulder now taper
to the paved shoulder at the concrete slope protection.

& & 5 peclikca-puben

@] Openfiosds Modeling

e -

Pomary ction
9| CCE_Target GSO_AT

' View 1, Default
-l @ eRFanmEm

[=Fl =

references

Figure 3-56: Add reference geometry
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Ditch and
grass

, shoulder
> taper

Figur 3-57: itch and grass shoulder taper

K. Next we are going to add several parametric constraints to further control the ditch
width hinge slope and back slopes.

Add a parametric constraint to the L3 Corridor from C-Adjust to B to control the
hinge height as shown:

arr il dd .| L @ DO & Y

,_{F",.—-— — >

Parameters .3

=]

Lock To Start ]

[ start 291+73.10
Lock To End ]

[ Stop 293+32.86
Constraint Label |-|C_HNG_HT
Start Value |'E.ﬂ'|]'|]'|]'

Stop Value |1}

Figure 3-58: Begin Hinge Values
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Properties vExX
|'| = View2, Default-30 {E=3 EeR | 1
. . — — P
E-S-b- i PPROADHEDFBTXE « SR
4 |2 3D Linear Element: +C_HNG
> @ ltems
N Line String
- i N Line String
= Ty
General a A
Element Det 3D Linear Blement
Le P_RDY_TL_Cut_Slc
Color ByLevel (9)
Line Style ByLevel (5)
Weight ByLevel (0)
Class Construction
Number of e 2
+C H N G Template  (None)
i Transparen 0
Geometry -~
Start Foint  2264937.3599".618!
End Point  2265801.7180".617}
Length  681.2077°
Feature -
F TL_Cut Slope Hingd
= Fe +C_HNG
=
L3 +C_HNG xtended ~
Belongs To: L3 Default-3D
Level: P_RDY_TL_Cut_Slope_Hinge (End Condiion Hinge 7/17/2025 11:06:1¢
M Modified
New New
Locked  Unlocked
Thickness 0.0000"
Line Style P

Figure 3-59: Begin Hinge, 3D View

Add a constraint from B to A to control the hinge height as shown:

Fi-dli-ll ® OO0 EE

@ Create Pa —
Parameters ~

Lock To Start ]

[] Start |293+32.36 |
Lock To End ]

[ Stop |295+32.85
Constraint Label [+C_HNG_HT  |v

StartValue  [0.0000

StopValue  [0.0000

Figure 3-60: End Hinge Values
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Figur 3-61: End Hinge, 3D View

The +DBF point is already controlled by the horizontal feature constraint but in
case you have any issues with the ditch tying in at the slope protection, a
parametric constraint can be added to make the ditch width zero in this area. Add
a constraint with the same start and end values to set the ditch width to zero in

this range:
Plwlfll e - | L W DI T &Y T |
4'?_3 Create Par - X
Parameters -

Lock To Start ]

[ Start |293+32.36 |
Lock To End ]

[ Stop |295+32.85 |
Constraint Label |SS_Width Ditch |~ |
Start Value |1]'.ﬂ'|]'|]'|]' |
Stop Value |1]'.ﬂ'|]'|]'|]' |

Figure 3-62: Set ditch width
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® View2, Defaut [=r=
E-S¥-b-[d LPRONDHNEREDITUXRS

Figure 3-63: Set ditch width, 3D View

Lastly, add a constraint with the same start and end values to set the back slope
to adjust between B to A to match the slope of the concrete slope protection (59.16
used in this example — 100% accurate slope protection not modeled as a part of
this exercise)

I Jz.s-:'ii'_f:i. o X

Parameters L3

Lock To Start O

[] Start 293+32.86
Lock To End ]

[ Stop |295+32.85
Constraint Label |55_5||::pe Cut

Start Value |33333=~

Stop Value |55'.'|E‘35=~

Figure 3-64: Backslope constraint
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Backslope ties in
to slope of slope
protection

Figure 3-65: Backslope constraint, 3D View

L. Any additional cleanup can be completed by following similar steps shown in other
modules or steps shown in this module.
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